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Getting Started

Package Contents

The following items are included in the Symphony I/O package.
Software and Firmware for this Apogee Product is available online only at 
http://www.apogeedigital.com/downloads.php#SYMIO

• Symphony I/O
• USB Cable
• Power Cable
• Rack Ears and Screws
• QuickStart Guide

http://www.apogeedigital.com/downloads.php#SYMIO
http://www.apogeedigital.com/downloads.php#SYMIO


An Introduction to the Symphony I/O System

Thank you for your purchase of Symphony I/O, the latest flagship digital audio interface 
from Apogee Electronics!
 
More than the latest High-end product from Apogee, Symphony I/O is the completion 
of the Symphony System and the platform for Apogee development and technology for 
years to come. Built to last and designed to meet the demands of the most discerning 
musicians, producers and engineers, Symphony I/O sets a new standard in digital 
audio interface quality, flexibility and ease of use.

• Next-generation A/D and D/A conversion quality

• Audio Interface Mode (AIM) technology for simple and direct connection to all 
popular audio workstations and formats

• Flexible and scalable I/O architecture to fit the needs of any studio

• Total software control with the new Apogee Maestro control software

• Unprecedented value



Audio Interface Mode (AIM)
The Audio Interface Mode (AIM) setting transforms the most fundamental 
characteristics of the Symphony I/O system to best match the host device to which 
Symphony I/O is connected. Rather than create a single hardware and software user 
interface that must adapt to all connection scenarios, the Audio Interface Mode 
customizes the user interface to your specific scenario, thus simplifying operation. If 
you change the way you connect your setup, select the appropriate Audio Interface 
Mode from the front panel. When switching between Audio Interface Modes as your 
workflow demands, the settings of each Mode are recalled automatically!

The following Audio Interface Modes are available:

Symphony - to connect to Symphony 64 PCI and Symphony Mobile Express/34 cards.

Pro Tools HD - to connect to Pro Tools HD PCI cards. Symphony I/O may be controlled 
from a Mac via USB, though the Mac connection isn’t required for audio operation.

USB Audio - to use Symphony I/O as a USB audio interface with an Apple Mac 
computer.

Standalone - to connect Symphony I/O to recording devices via ADAT, S/PDIF or AES 
inputs and outputs. Symphony I/O may be controlled from a Mac via USB, though the 
Mac connection isn’t required for audio operation.



Flexible Input/Output Architecture
Several I/O Modules are available, allowing the customization of Symphony I/O’s inputs 
and outputs to your particular requirements.
 
The following I/O Modules are available:
 
8 Analog I/O + 8 AES I/O
8 channels of Analog and 8 channels of AES I/O simultaneously

• 8 analog inputs and outputs
• 8 AES inputs and outputs
• Stereo S/PDIF Coax input and output.

8 Analog I/O + 8 Optical I/O
8 channels of Analog I/O and up to 8 channels of Optical I/O simultaneously

• 8 analog inputs and outputs
• 8 channels of ADAT/SMUX inputs and outputs or a stereo S/PDIF optical input and 

output
• Stereo S/PDIF coax input and output.

16 Analog IN + 16 Optical OUT
16 channels of Analog INPUT and up to 16 channels of Digital OUTPUT simultaneously

• 16 analog inputs
• 16 channels of ADAT/SMUX outputs or 2 stereo S/PDIF optical outputs
• Stereo S/PDIF coax input and output

16 Analog OUT + 16 Optical IN
16 channels of Analog OUTPUT and up to 16 channels of Digital INPUT simultaneously

• 16 analog outputs
• 16 channels of ADAT/SMUX inputs or a 2 stereo S/PDIF optical inputs
• Stereo S/PDIF coax input and output

8 Mic Preamp
8 Mic preamps with 4 instrument inputs and 8 insert points

• 8 Mic Pre inputs, with 70 dB of gain, 48v phantom power
• 4 Instrument inputs
• 8 assignable analog insert sends and returns

Hardware and Software Control
Symphony I/O’s operating parameters may be set from a variety of hardware and 
software controls, listed below. Though several options are offered, you may choose 
the hardware and software controls that best suit your individual preferences.



Symphony I/O Front Panel 

Basic parameters such as levels and clocking may be set using the two front panel 
encoders.

Apogee Maestro Software 

Apogee Maestro provides complete control of all Symphony I/O settings.



Apple OS X Control Panels 
Levels and some clock parameters may be set from the OS X System Preferences > 
Sound window and the Audio MIDI Setup utility.

Apple Mac Keyboard 
Set output levels directly from your Mac keyboard’s volume control.



Symphony I/O Release 4 Requirements
 

Symphony Audio Interface Mode

 
Requirements when connecting to Symphony 64 or Mobile PCI cards:

• Apogee Symphony 64 or Apogee Symphony Mobile PCI card (sold separately)
• OS X Snow Leopard 10.6.4 or OS X Lion 10.7 or greater (64-bit and 32-bit kernel 

modes)
• Symphony 64 - Apple Mac Pro - 2GB memory required, 4 GB recommended

Important - Use Symphony 64 Driver 1.1.4 or greater, included in the Symphony I/O 
Release 4 Software Installer.

• Symphony Mobile - Apple MacBook Pro with an Express/34 card slot - 2GB 
memory required, 4 GB recommended

• Important - Use Symphony Mobile Driver 1.0.53 or greater, included in the 
Symphony I/O Release 4 Software Installer.

 
 



Pro Tools HD Audio Interface Mode

A Symphony I/O based Pro Tools system consists of two independent computer 
connections: audio (to a Pro Tools HD PCI card) and software control (via USB to an 
Intel Mac running Maestro 2). In the case where PCI cards are installed in a PowerPC 
Mac or Windows computer, it’s possible to run Maestro from a separate Intel Mac, such 
as Mac Mini or MacBook.
 
Requirements when connecting to Avid Pro Tools PCI Cards:
Avid Pro Tools HD Core, HD Process, HD Accel PCI, HD Accel Core, HD Accel or HD 
Native PCIe card installed in a computer in accordance with the Pro Tools HD 
Compatibility Grids, available at www.avid.com
Pro Tools 8.1, 9.0 or greater 10.0 or greater

Requirements to run Maestro software, to control Symphony I/O via USB:
OS X Snow Leopard 10.6.4 or OS X Lion 10.7 or greater (64-bit and 32-bit kernel 
modes)
Apple Intel Mac

http://www.avid.com/
http://www.avid.com/


Symphony PCI Quick Start Guide
This Quick Start Guide describes how to configure one Symphony I/O with a Symphony 
PCI card or other device to record and play back audio.

Step 1 - Install the Symphony 64 PCIe Card (sold separately)
a. Power down the Mac and wait for 5-10 minutes.
b. Disconnect all external cables to the Mac except the AC power cable.
c. Touch the Mac’s metal PCI access covers to discharge any static electricity in 

your body.
d. Disconnect the AC Cable.
e. Remove the Mac’s side cover and carefully put it aside.
f. Remove the Mac’s PCI bracket by unscrewing the two thumb screws on the 

bracket. 
g. Holding the Symphony PCIe card by its corners, align the card's connector with 

the desired PCI slot and press the card firmly into place. 

If the card does not slide into place with minimal effort, remove the card, check 
alignment, and check for foreign objects.

h. Once the card is installed, re-attach the PCI bracket to secure the Symphony 64 
card. 

i. Re-install the Mac’s side panel.



Step 2 - Connect Symphony I/O to the Symphony 64 Card
Using the 3 meter PC-32 cable included with the Symphony 64 card, connect the 
Symphony I/O’s Main port to the Symphony 64 PCIe card’s Channels 1-32 port as 
shown below.



Step 3 - Download and Install Symphony I/O Software

Download the most current Symphony I/O Release package from the Apogee website: 
http://www.apogeedigital.com/downloads.php#SYMIO
 
Once downloaded, the package will open automatically to reveal the following 
contents:

• Symphony I/O Software Installer
• Symphony I/O Uninstaller
• Symphony I/O User’s Guide
• Read-Me

Double-click on the Symphony I/O Software Installer icon and follow the onscreen 
directions provided by the installer program.
Following installation, you will be required to restart your Mac.

Step 4 - Connect Headphones, Speakers and Inputs

Connect line inputs to rear panel analog inputs 1-2 using an Apogee AD8-IFC cable 
or equivalent.

http://www.apogeedigital.com/downloads.php#SYMIO
http://www.apogeedigital.com/downloads.php#SYMIO
http://store.apogeedigital.com/breakout-cables.php%23ad8ifc
http://store.apogeedigital.com/breakout-cables.php%23ad8ifc


Connect speakers to the rear panel analog outputs 1-2 using an Apogee DA8-IFC 
cable or equivalent.

Step 5 - Playback from iTunes
After restarting your Mac, a dialog box will prompt you to choose Symphony 64 for Mac 
sound output. Click Yes.

Open Apple iTunes and play an audio selection.
Using the front panel left hand encoder, select the speaker or  headphone icon; use 
the right hand encoder to adjust the playback level of the selected output.

 

http://store.apogeedigital.com/breakout-cables.php%23da8ifc
http://store.apogeedigital.com/breakout-cables.php%23da8ifc
http://store.apogeedigital.com/breakout-cables.php%23da8ifc
http://store.apogeedigital.com/breakout-cables.php%23da8ifc


Step 6 - Configure Apple Logic Pro
Logic 9.1.1 or greater recommended

a. Launch Logic Pro
b. Open Preferences > Audio 
c. Click the Devices Tab, then the Core Audio Tab
d. Set Input Device and Output Device to Symphony 64
e. Set the I/O Buffer Size to 64
f. Check the Enabled box
g. Click Apply Changes

 

By selecting Symphony I/O input and output labels in Logic, the labels you see in 
Logic’s Channel Strip input and output slots correspond exactly to Symphony I/O’s 
hardware inputs and outputs, making I/O assignment much easier.



a. In Logic, choose Options > Audio > I/O Labels
b. Select the labels in the Provided by Driver column
c. Close the I/O Labels window

Step 7 - Open Apogee Maestro Software
Apogee Maestro software provides complete control of all Symphony I/O settings, from 
levels to formats to routing. 



Open Maestro by clicking on the Apogee Maestro icon found in the Applications folder.

 



Pro Tools PCI Quick Start Guide
This Quick Start Guide describes how to configure one Symphony I/O with an Avid Pro 
Tools HD PCI card to record and play back audio.

Step 1 - Install Pro Tools HD cards
Install Pro Tools HD cards and Pro Tools software as described in the Avid 
documentation entitled "Getting Started with Pro Tools HD".

Step 2 - Connect Symphony I/O to the Pro Tools HD PCI Card
Using the 3 meter DigiLink cable included with the Pro Tools HD card (or an Apogee 
PC-32 IFC Cable), connect the Symphony I/O’s Main port to the HD Core card port as 
shown below.



Step 3 - Connect Symphony I/O to the Software Remote Mac
 
Using a standard Type A - Type B USB cable, connect Symphony I/O's USB port to an 
Apple Intel Mac USB port. Ensure that the cable is certified for USB 2.0 operation.

• When Audio Interface Mode is set to Pro Tools HD, a USB connection between 
Symphony I/O and an Intel Mac provides the link between Apogee Maestro 
software and Symphony I/O, in order to make calibration, meter configuration, 
digital format and other settings.

• Symphony I/O's clock source and sample rate are set from Pro Tools software, 
and don't require the USB connection.

• The USB connection is only required to make Maestro settings, and may be 
removed once settings are complete.

• Note that the audio and USB connections don't have to be made to the same 
computer, allowing Symphony I/O to be connected to Pro Tools HD cards installed 
in Apple Mac G5 or Windows computers while running Maestro on an Apple Intel 
Mac.

 
Step 4 - Download and Install Symphony I/O Software
Download the most current Symphony I/O Release package from the Apogee website: 
http://www.apogeedigital.com/downloads.php#SYMIO

Once downloaded, the package will open automatically to reveal the following 
contents:

• Symphony I/O Software Installer
• Symphony I/O Uninstaller
• Symphony I/O User’s Guide
• Read-Me

Double-click on the Symphony I/O Software Installer icon and follow the onscreen 
directions provided by the installer program.

Following installation, you will be required to restart your Mac.

http://www.apogeedigital.com/downloads.php#SYMIO
http://www.apogeedigital.com/downloads.php#SYMIO


Step 5 - Connect Headphones, Speakers and Inputs

Connect line inputs to rear panel analog inputs 1-2 using an Apogee AD8-IFC cable 
or equivalent.

Connect speakers to the rear panel analog outputs 1-2 using an Apogee DA8-IFC 
cable or equivalent.

http://store.apogeedigital.com/breakout-cables.php%23ad8ifc
http://store.apogeedigital.com/breakout-cables.php%23ad8ifc
http://store.apogeedigital.com/breakout-cables.php%23da8ifc
http://store.apogeedigital.com/breakout-cables.php%23da8ifc
http://store.apogeedigital.com/breakout-cables.php%23da8ifc
http://store.apogeedigital.com/breakout-cables.php%23da8ifc


Step 6 - Configure Pro Tools Software
1. Once Steps 1-4 have been completed, launch Pro Tools software and open a 

session.
2. Once the session is open, choose Setup > Hardware. In the Hardware Setup 

window, click Set to Default.
3. Choose Setup > I/O and click the Input tab.
4. Delete all paths by Option-clicking the audio paths column on the left side of the 

window, then click Default.
5. Click the Output and Insert tabs and repeat step 4.

Step 7 - Playback from Pro Tools Software
Route audio playback to Outputs 1-2 in Pro Tools, and press Play.
Using the front panel left hand encoder, select the speaker or headphone icon; use the 
right hand encoder to adjust the playback level of the selected output.

Step 8 - Open Apogee Maestro Software
Apogee Maestro software provides complete control of all Symphony I/O settings, from 
levels to formats to routing. 

Open Maestro by clicking on the Apogee Maestro icon found in the Applications folder.



Symphony I/O Features
This chapter describes each feature of the Symphony I/O hardware interface.
 

• Symphony I/O Front Panel
• Symphony I/O Rear Panel
• 8 Analog + 8 Optical IO Module
• 8 Analog + 8 AES IO Module
• 16 Analog IN + 16 Optical Out I/O Module
• 16 Analog Out + 16 Optical In I/O Module

Symphony I/O Front Panel

 
1. Power Button - When the rear panel AC Input is connected to an AC wall socket, 

the power switch and the Apogee icon will glow softly, indicating that Symphony I/O 
is in Standby. Press the power button for a half second to power up Symphony I/O. 
Symphony I/O may be configured to power on as soon as an AC voltage is present 
on the rear panel AC Input. You may find this preferable when using an external 
power switch (such as an equipment rack power strip) to power on the unit. See 
AutoPower for details.

2. Level Meter Banks - Each bank of 8 10-segment level meters may be configured in 
Maestro to display analog or digital inputs or outputs.

3. Meter source LEDs - These LED pointers indicate the signal 
source of each meter bank. For each bank, the format (Analog 
or Digital) and type (Input or Output) are indicated with a small 
triangle. For example, when Bank 1 is configured to display 
analog inputs and Bank 2 is configured to display analog 
outputs, the meter source LEDs appear as shown below.

4. Clock source LEDs - The four clock source LEDs (INTernal, 
WC, DIGital, LOOP) indicate Symphony I/O’s clock source. For the 
details of how to set the clock source, see Setting the Clock Source.

5. Sample Rate Display - These 7-segment LEDs display Symphony I/O’s sample 
rate. For the details of how to set the the sample rate, see Setting the Sample Rate.

http://support.apogeedigital.com/help/symphony-io/pgs/sio_overview.html#front_panel
http://support.apogeedigital.com/help/symphony-io/pgs/sio_overview.html#front_panel
http://support.apogeedigital.com/help/symphony-io/pgs/sio_overview.html#rear_panel
http://support.apogeedigital.com/help/symphony-io/pgs/sio_overview.html#rear_panel
http://support.apogeedigital.com/help/symphony-io/pgs/sio_overview.html#8analog_8optical_module
http://support.apogeedigital.com/help/symphony-io/pgs/sio_overview.html#8analog_8optical_module
http://support.apogeedigital.com/help/symphony-io/pgs/sio_overview.html#8analog_8aes_module
http://support.apogeedigital.com/help/symphony-io/pgs/sio_overview.html#8analog_8aes_module
http://support.apogeedigital.com/help/symphony-io/pgs/sio_overview.html#16analogIN_16opticalOUT
http://support.apogeedigital.com/help/symphony-io/pgs/sio_overview.html#16analogIN_16opticalOUT
http://support.apogeedigital.com/help/symphony-io/pgs/sio_overview.html#16analogOUT_16opticalIN
http://support.apogeedigital.com/help/symphony-io/pgs/sio_overview.html#16analogOUT_16opticalIN
http://support.apogeedigital.com/help/symphony-io/pgs/hardware_auto_power.html
http://support.apogeedigital.com/help/symphony-io/pgs/hardware_auto_power.html


6. Front panel encoders - The front panel encoders may be used to make a variety of 
settings, from listening levels to sample rate, clock source and Audio Interface 
Mode. The various encoder functions are described in the chapters Configuring 
your Symphony I/O System and Working with your Symphony I/O System.

7. Front panel OLED Display - The front panel OLED Display provides user feedback 
on input and output levels, system status and other Symphony I/O parameters.

8. 1/4" Headphone Outputs - These 1/4" connectors provide individually assignable 
stereo headphone outputs.

9. Removable Rack Ears - Rack ears are included in the Accessories box for 
mounting Symphony I/O in a standard 19” equipment rack.

Symphony I/O Rear Panel

 

 
1. Card 1 slot - All I/O Modules except the Mic Pre Module card may be installed in 

the Card 1 slot. Note that the Card 1 slot is the lower slot. The first I/O Module card 
must be installed in this slot.

2. Card 2 slot - Once a module has been installed in the Card 1 slot, an additional 
module may be installed in this slot. Mic Pre Modules must be installed in this slot.

3. Cooling Fan - The cooling fan is automatically controlled by an internal thermostat. 
There are no user controls for the fan.

4. Symphony Main - This PC-32 port is used to connect Symphony I/O to a 
Symphony 64 or Mobile PCI card. This port may also be used to chain multiple 
Symphony I/Os.



5. Symphony Thru - This PC-32 port is used to chain together multiple Symphony I/
Os for connection to one PCI card port.

6. Ethernet - This RJ-45 port is included for future development purposes.

7. USB - This USB “Type B” receptacle is used to connect Symphony I/O to an Apple 
Mac computer. If Audio Interface Mode is set to USB Audio, audio may be 
streamed to and from the Mac.

8. WC Term - This push-on, push-off button engages 75 ohm termination on the WC In 
BNC connector.

9. WC In - This BNC accepts word clock signals, allowing Symphony I/O to clock to 
external devices.

10.WC Out - This BNC transmits word clock signals, allowing Symphony I/O to clock 
external devices.

11.Loop In - When “Use Loop Sync” is checked, this input accepts a Loop clock 
signal from the Loop Out of another Symphony I/O.

12.Loop Out - When “Use Loop Sync” is checked, this output provides a Loop clock 
signal suitable for clocking another Symphony I/O.

13.AC Input - This IEC connector accepts an AC input of 100 to 250 volts at 47 to 63 
Hz. No internal adjustments are required to power Symphony I/O from an AC 
connection in this range.



8 Analog I/O + 8 Optical I/O Module

1. Analog IN - This DB-25 connector accepts 8 analog balanced line level inputs. 
When a Mic Pre Option card is installed in slot 2, this connector accepts the 8 
balanced microphone level signals. The connector is wired to the "Tascam" 8 
channel format. The hex screw (to secure mating connectors) accepts a 4-40 
threaded thumbscrew. See Analog IN Pinout for detailed wiring information.

2. Analog OUT - This DB-25 connector provides 8 analog balanced line level outputs. 
The connector is wired to the "Tascam" 8 channel format. The hex screw (to secure 
mating connectors) accepts a 4-40 threaded thumbscrew. See Analog OUT Pinout 
for detailed wiring information.

3. Optical IN S/PDIF-ADAT-SMUX - This Toslink connector accepts optical inputs in 
S/PDIF, ADAT or SMUX format. The format is selected in Maestro's Device Settings 
tab window. When optical format is SMUX (i.e. optical format is set to ADAT/SMUX 
and the sample rate is 88.2-96kHz), this Toslink connector accepts channels 1-4 of 
the SMUX input stream.

4.  Optical IN SMUX - When optical format is SMUX, this Toslink connector accepts 
channels 5-8 of the SMUX input stream.

5. Optical OUT S/PDIF-ADAT-SMUX -This Toslink connector provides optical outputs 
in S/PDIF, ADAT or SMUX format. When optical format is set to SMUX, this Toslink 
connector outputs channels 1-4 of the SMUX input stream.

6. Optical OUT SMUX - When optical format is SMUX, this Toslink connector outputs 
channels 5-8 of the SMUX input stream.

7. S/PDIF IN - This coaxial RCA (Cinch) connector accepts a S/PDIF stereo input. 
Routing of the S/PDIF input is set with the S/PDIF Replaces drop down menu, found 
in Maestro’s Input tab window.

8. S/PDIF OUT - This coaxial RCA (Cinch) connector provides a S/PDIF stereo output. 
Routing of the S/PDIF Output is set with the S/PDIF Mirrors drop down menu, found 
in Maestro’s Output tab window.



8 Analog I/O + 8 AES I/O Module

1. Analog IN - This DB-25 connector accepts 8 analog balanced line level inputs. 
When a Mic Pre Option card is installed in slot 2, this connector accepts the 8 
balanced microphone level signals. The connector is wired to the "Tascam" 8 
channel format. The hex screw (to secure mating connectors) accepts a 4-40 
threaded thumbscrew. See Analog IN Pinout for detailed wiring information.

2. Analog OUT - This DB-25 connector provides 8 analog balanced line level outputs. 
The connector is wired to the "Tascam" 8 channel format. The hex screw (to secure 
mating connectors) accepts a 4-40 threaded thumbscrew. See Analog OUT Pinout 
for detailed wiring information.

3. AES IN/OUT - This DB-25 connector accepts 8 AES digital inputs and provides 8 
AES outputs. The connector is wired to the "Yamaha" 8 channel AES format. The hex 
screw (to secure mating connectors) accepts a 4-40 threaded thumbscrew. See 
AES IN/OUT Pinout for detailed wiring information.

4. S/PDIF IN - This coaxial RCA (Cinch) connector accepts a S/PDIF stereo input. 
Routing of the S/PDIF input is set with the S/PDIF Replaces drop down menu, found 
in Maestro’s Input tab window.

5. S/PDIF OUT - This coaxial RCA (Cinch) connector provides a S/PDIF stereo output. 
Routing of the S/PDIF Output is set with the S/PDIF Mirrors drop down menu, found 
in Maestro’s Output tab window.



16 Analog IN + 16 Optical Out I/O Module

1. Analog IN 1 - This DB-25 connector accepts analog balanced line level inputs 1-8. 
When a Mic Pre Option card is installed in slot 2, this connector accepts the 8 
balanced microphone level signals. The connector is wired to the "Tascam" 8 
channel format. The hex screw (to secure mating connectors) accepts a 4-40 
threaded thumbscrew. See Analog IN Pinout for detailed wiring information.

2.  Analog IN 2 - This DB-25 connector accepts analog balanced line level inputs 
9-16, with similar characteristics to the Analog IN 1 connector.

3. Optical OUT 1 S/PDIF-ADAT-SMUX -This Toslink connector provides optical 
outputs 1-8 in S/PDIF, ADAT or SMUX format. When optical format is set to SMUX, 
this Toslink connector outputs channels 1-4 of the SMUX output stream.

4. Optical OUT 1 SMUX - When optical format is SMUX, this Toslink connector outputs 
channels 5-8 of the SMUX output stream.

5. Optical OUT 2 S/PDIF-ADAT-SMUX -This Toslink connector provides optical 
outputs 9-16 in S/PDIF, ADAT or SMUX format. When optical format is set to SMUX, 
this Toslink connector outputs channels 9-12 of the SMUX output stream.

6. Optical OUT 2 SMUX - When optical format is SMUX, this Toslink connector outputs 
channels 13-16 of the SMUX output stream.

7. S/PDIF IN - This coaxial RCA (Cinch) connector accepts a S/PDIF stereo input. 
Routing of the S/PDIF input is set with the S/PDIF Replaces drop down menu, found 
in Maestro’s Input tab window.

8. S/PDIF OUT - This coaxial RCA (Cinch) connector provides a S/PDIF stereo output. 
Routing of the S/PDIF Output is set with the S/PDIF Mirrors drop down menu, found 
in Maestro’s Output tab window.



16 Analog Out + 16 Optical In I/O Module

1. Analog OUT 1 - This DB-25 connector provides analog balanced line level outputs 
1-8. The connector is wired to the "Tascam" 8 channel format. The hex screw (to 
secure mating connectors) accepts a 4-40 threaded thumbscrew. See Analog OUT 
Pinout for detailed wiring information.

2. Analog OUT 2 - This DB-25 connector provides analog balanced line level outputs 
9-16, with similar characteristics to the Analog OUT 1 connector.

3. Optical IN 1 S/PDIF-ADAT-SMUX -This Toslink connector accepts optical inputs 
1-8 in S/PDIF, ADAT or SMUX format. When optical format is set to SMUX, this 
Toslink connector accepts channels 1-4 of the SMUX input stream.

4. Optical OUT 1 SMUX - When optical format is SMUX, this Toslink connector 
accepts channels 5-8 of the SMUX input stream.

5. Optical OUT 2 S/PDIF-ADAT-SMUX -This Toslink connector accepts optical inputs 
9-16 in S/PDIF, ADAT or SMUX format. When optical format is set to SMUX, this 
Toslink connector accepts channels 9-12 of the SMUX inpuput stream.

6. Optical OUT 2 SMUX - When optical format is SMUX, this Toslink connector 
accepts channels 13-16 of the SMUX input stream.

7. S/PDIF IN - This coaxial RCA (Cinch) connector accepts a S/PDIF stereo input. 
Routing of the S/PDIF input is set with the S/PDIF Replaces drop down menu, found 
in Maestro’s Input tab window.

8. S/PDIF OUT - This coaxial RCA (Cinch) connector provides a S/PDIF stereo output. 
Routing of the S/PDIF Output is set with the S/PDIF Mirrors drop down menu, found 
in Maestro’s Output tab window.



Mic Pre I/O Module

1. INSTRUMENTS 1-4 - These 1/4" TS connectors accept input from a wide range of 
instruments, including keyboards, guitars and other electronic instruments. The 
input impedance is high enough to avoid the loading of input sources such as 
passive electric guitars and basses.

2. INSERTS Send 1-8 - This DB-25 connector provides 8 analog balanced line level 
sends routed after each channel's mic preamp stage. See Analog OUT Pinout for 
detailed wiring information.

3. INSERTS Return 1-8 - This DB-25 connector aceepts 8 analog balanced line level 
returns routed before each channel's A/D conversion stage. See Analog IN Pinout 
for detailed wiring information.Use the INSERT sends and returns to insert analog 
line level gear (such as compressors and equalizers) between a channel's mic 
preamp and A/D conversion stage.



How does the 8 Mic Preamp Module work?
The Mic Preamp Module upgrades the functionality of any Analog I/O Module by 
adding mic preamps to the existing line inputs. A direct connection between the Mic 
Preamp Module and the Analog I/O Module inserts a mic preamp stage before the line 
inputs.



Maestro Features
While basic settings may be made from the front panel, Symphony I/O has been 
designed primarily to be controlled from Apogee Maestro software.
 

• Devices Sidebar
• Device Icon and ID Button
• Input Tab Window
• Output Tab Window
• Device Settings Tab Window
• Routing Tab Windows
• Input Routing Tab Window
• Output Routing Tab Window
• System Setup Tab Window
• System Setup - Symphony PCI
• Toolbar
• Menu Bar Menus

 

Devices Sidebar
 Any Maestro-compatible Apogee interfaces connected to the host computer are 
displayed in the Devices sidebar, regardless of whether the connection is made via 
Symphony PCI card, USB or FireWire. Hardware settings are displayed by first 
selecting one or more interfaces in the Devices sidebar and then clicking on a tab.
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Device Icon & ID Button

 

A device icon and ID button is placed adjacent to each row of parameters to identify 
the hardware unit to which the row belongs. By clicking on the ID button, the 
corresponding hardware unit’s front panel will illuminate. 

Each hardware unit is assigned a Peripheral Prefix (A-Z, found in Maestro’s Device 
Settings tab window) which is displayed on the ID button.



Input Tab Window

Settings for Symphony I/O’s analog and digital inputs are found on the Input tab 
window.

1. Device Icon & ID Button - see the description above.
2. Show/Hide Trims - Click this button to display or hide all Trim faders.
3. Reset Trims - Click this button to reset all Trim faders.

 
The following controls set the gain for each analog to digital (A/D) channel, and may be 
used to calibrate Symphony I/O’s analog to digital converters. The calibration process 
is described in greater detail in Calibrating Symphony I/O.

4. Analog Ref Level - When calibrating Symphony I/O, use this drop down menu to 
choose the analog reference level for each A/D conversion channel. Option-select 
any channel to set the analog reference for all channels.
5. Digital Ref Level - Use this pop-up menu to choose the digital reference level for 
each A/D conversion channel. Option-select any channel to set the digital reference 
for all channels.
6. Soft Limit - Use this pop-up menu to engage one of four Soft Limit 
characteristics. See Using Soft Limit for a complete description of the Soft Limit 
settings.
7. Trim Fader - Once the desired reference levels have been chosen, click Show 
Trims, then use the Trim Fader to precisely trim the A/D conversion level within +- 
0.1 dB. Note that numerical values may be entered directly in the Trim level readout. 
Press Tab to advance to the adjacent Trim level readout for quickly 
8. A/D Converter Meter - This meter displays the level of the input after A/D 
conversion in the range -48 to 0 dBfs.
9. Meter Level Readout - This indicator provides an accurate reading of the analog 
input meter to an accuracy of 0.1 dB. The reading is used primarily to calibrate the 
A/D converter stage with a steady input tone.
10. S/PDIF Replaces - To use the S/PDIF Coax input, it’s necessary to select 
another analog or digital channel pair which the S/PDIF Coax input will replace on 
the Input Routing grid. Use this drop down menu to select the channel pair to be 
replaced.
11. Digital Input Meter - This meter displays the level of digital inputs.
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Output Tab Window

1. Device Icon & ID Button - see the description above.
2. Show/Hide Trims - Click this button to display or hide all Trim faders.
3. Reset Trims - Click this button to reset all Trim faders.

 
The following controls set the gain for each digital to analog (D/A) channel, and may be 
used to calibrate Symphony I/O’s digital to analog converters. The calibration process 
is described in greater detail in the section entitled Calibrating Symphony I/O.
 

4. Analog Ref Level - When calibrating Symphony I/O, use this drop down menu to 
choose the analog reference level for each D/A conversion channel. Option-select 
any channel to set the analog reference for all channels.
5. Digital Ref Level - Use this pop-up menu to choose the digital reference level for 
each D/A conversion channel. Option-select any channel to set the digital reference 
for all channels.
6. Trim Fader - Once the desired reference levels have been chosen, click Show 
Trims, then use the Trim fader to precisely trim the D/A conversion level within +- 0.1 
dB. Please note that, because the D/A Meter displays the digital signal before 
conversion, it's necessary to measure the analog output with an external voltmeter 
when calibrating.
7. D/A Meter - This meter displays the level of the output before D/A conversion, in 
the range -48 to 0 dBfs.
 
The following settings control the configuration and level of the rear panel analog 
outputs and front panel headphone outputs. Please consult Configuring Speaker 
and Headphone Outputs for more details.

8. Speaker Out Selection - The analog outputs may be configured for use with 
active speakers or a power amp/passive speaker combination.
9. Speaker Out Level - When analog outputs are configured as speaker outputs, 
this knob controls the output level.
10. HP 1 Level - This knob controls the output level of the front panel HP 1 output.

http://support.apogeedigital.com/help/symphony-io/pgs/configuring_calibration.html
http://support.apogeedigital.com/help/symphony-io/pgs/configuring_calibration.html
http://support.apogeedigital.com/help/symphony-io/pgs/configuring_speakers.html
http://support.apogeedigital.com/help/symphony-io/pgs/configuring_speakers.html
http://support.apogeedigital.com/help/symphony-io/pgs/configuring_speakers.html
http://support.apogeedigital.com/help/symphony-io/pgs/configuring_speakers.html


11. HP 1 Source - This drop down is used to select the source for the front panel 
HP 1 output.
12. HP 2 Level - This knob controls the output level of the front panel HP 2 output.
13. HP 2 Source - This drop down is used to select the source for the front panel 
HP 2 output.
14. S/PDIF Mirrors - The S/PDIF coaxial output may be set to mirror (i.e transmit in 
parallel) any of the analog or digital output pairs on the routing grid. Use this pop-
up menu to select the output pair that is mirrored by the S/PDIF coaxial output.
15. Digital Output Meter - This meter displays the level of digital outputs.

Input/Output Tab Windows - Parameter Order
 
Regardless of the type and number of installed I/O Modules, parameters appear in the 
Input and Output tab windows in the following order from left to right:
 

1. all analog input or output controls
2. analog speaker and headphone controls
3. S/PDIF Coax Replaces or Mirrors settings
4. digital input or output meters.

 
For example, if an 8 Analog I/O + 8 AES I/O Module is installed in Symphony I/O's 
lower slot and a 16 Analog In + 16 Optical Out is installed in the upper slot, parameters 
appear in the Input tab window in the following order:

1. 24 analog input controls
2. One S/PDIF Replaces drop-down for each I/O Module
3. 8 AES input meters.
 



Parameters appear in the Output tab window in the following order:

1. 8 Analog output controls
2. analog speaker and headphone controls
3. one S/PDIF Mirrors drop-down for each I/O Module
4. 8 AES output meters
5. 16 Optical output meters.
 

Device Settings Tab Window

1. Device icon & ID button - see the description above.
2. Peripheral Prefix - Use this drop down menu to assign a letter prefix (A-Z) to 

each peripheral device displayed in the Devices Sidebar. The letter prefix is 
included in all graphic representations of the peripheral as well as I/O labels in 
Maestro and Core Audio compatible applications. 

3. Audio Interface Mode - This window displays the currently selected Audio 
Interface Mode. The Audio Interface Mode must be selected from Symphony I/
O's front panel.



4. Meters - Select the audio channels to be displayed on the two front panel meter 
banks using these radio buttons. The Meter Bank 1 radio buttons select the audio 
channels to display on the the left hand meter bank, and the Meter Bank 2 radio 
buttons select the audio channels to display on the right hand meter bank.

5. Optical Format - This pop-up sets the format of the rear panel optical Toslink 
connectors (when an I/O Module with optical inputs and/or outputs is installed).

Routing Tab Windows
 
The functionality of the Routing tab windows vary based on the audio interface mode 
selected. Each audio interface mode is described below.
 
Input Routing -Symphony Audio Interface Mode
The Input Routing tab window determines how Symphony I/O hardware inputs are 
routed to audio software inputs.
 

 
1. Hardware Inputs Row - The hardware analog and digital inputs of all 

peripherals connected to the Symphony PCI card are displayed in this row.
2. Software Inputs Column - Available audio software inputs are listed in this 

column in pairs (1-2, 3-4, etc).
3. Software Input Labels - Once a connection has been made between hardware 

and software inputs, the software input label (consisting of the peripheral prefix 
plus the hardware input label) appears in this field.



For these labels to appear in your audio software input/output assignments, 
ensure that the software is set to accept labels transmitted through Symphony’s 
Core Audio driver.

 
Audio connections between hardware and software inputs are made by positioning 
markers on the routing grid at the intersection of the desired hardware and software 
channels. By default, hardware inputs are routed sequentially to software inputs. Note 
that the movement of the markers is restricted based on the routing capability of the 
system. On the Input Routing page, one hardware input may be assigned to multiple 
software inputs (in effect splitting the signal) but multiple hardware inputs may not be 
assigned to one software input (an operation which would require the summing of input 
signals). Each marker's range of motion is indicated by the horizontal shading on the 
routing grid, as depicted above by arrows on the Input routing grid.
 

Output Routing - Symphony Audio Interface Mode
The Output Routing tab window determines how audio software outputs are routed to 
Symphony I/O hardware outputs.

 
1. Hardware Outputs Row - The hardware analog and digital outputs of all 

peripherals connected to the Symphony card are displayed in this row.
2. Hardware Inputs Column - Available audio software outputs are listed in this 

column in pairs (1-2, 3-4, etc).
3. Software Output Labels - Once a connection has been made between 

software and hardware outputs, the software output label (consisting of the 
peripheral prefix plus the hardware output label) appears in this field.



 
Manipulation of the Output Routing Tab Window is essentially the same as the Input 
Routing Tab Window, with the important distinction that one software output may be 
assigned to multiple hardware outputs but multiple software outputs may not be 
assigned to one hardware output. Each marker's range of motion is indicated by the 
vertical shading on the routing grid, as depicted above by arrows on the Output routing 
grid.
 
Note that each marker represents an odd/even pair of audio signals - it's not possible 
to route the odd and even signal of a pair to different destinations.

Standalone Routing - Standalone Audio Interface Mode
When audio interface mode is set to Standalone, only one routing tab (called the 
Standalone Routing tab window, unsurprisingly) is displayed. The Standalone Routing 
tab window determines how hardware inputs (on installed I/O Modules) are routed to 
hardware outputs. In Standalone mode, the PC-32 audio streams (to and from a 
Symphony 64 card) are not active, and thus don't appear on the grid. If multiple 
Symphony I/O in Standalone audio interface mode are detected, a separate 
Standalone Routing grid is displayed for each interface.
 

 
1. Hardware Output Row - The hardware analog and digital outputs of the 

Symphony I/O are displayed in this row.
2. Hardware Input Column - The hardware analog and digital inputs of the 

Symphony I/O are displayed in this row.



 
Audio connections between hardware inputs and outputs are made by positioning 
markers on the routing grid at the intersection of the desired hardware input and 
output. By default, analog inputs are routed sequentially to digital outputs and digital 
inputs are routed to analog outputs, the desired routing to use Symphony I/O as a 
standalone A-to-D and D-to-A converter. Similar to the Input and Output Routing grids 
(Symphony audio interface mode) marker movement is restricted based on the routing 
capability of the system. One hardware input may be assigned to multiple hardware 
outputs (in effect splitting the signal) but multiple hardware inputs may not be assigned 
to one hardware output (an operation which would require the summing of input 
signals). Each marker's range of motion is indicated by the vertical shading on the 
routing grid, as depicted above by arrows on the Standalone routing grid.
 
Routing - Pro Tools HD Audio Interface Mode
When Audio Interface Mode is set to Pro Tools HD, Routing tabs don't appear in 
Maestro.
All routing between Symphony I/O and Pro Tools HD PCI cards is fixed.
Hardware routing may be set in Pro Tools' I/O Setup window.
 



System Setup Tab Window
In most cases, the Symphony I/O hardware interface is part of a larger Mac-based 
audio system, such as Symphony PCI or USB Core Audio. Settings that encompass the 
integrated hardware-software system are found on this tab window. As the available 
settings vary according to the selected Audio Interface Mode, the System Setup tab 
window is described individually for each Audio Interface Mode.

System Setup - Symphony Audio Interface Mode
When audio interface mode is set to Symphony, the following controls are displayed:

1. Clock Source - This drop down selects the clock source for the loop sync master 
interface, which in turn provides a clock signal to the rest of the system. 

The following sources may be selected.
• Internal - Symphony I/O is clocked from its internal crystal.
• WC - Symphony I/O is clocked from an external word clock signal connected to the 

rear panel WC input.
• Digital - Symphony I/O is clocked from a digital audio input. The digital clock sources 

listed in the drop down menu vary according to the digital audio inputs included on 
the installed I/O cards.

2. Sample Rate - This drop down selects the Symphony System sample rate. Under 
certain circumstances, (for example, when a DAW session is open) this setting will be 
overridden by software sample rate settings.
 
The following settings determine the behavior of the front panel and Maestro 
software level meters.
 
3. Peak Hold - This pop-up menu sets the time that peak indications are held on 
software and front panel meters.



4. Over Hold - This pop-up menu sets the time that over indications are held on 
software and front panel meters.
See Working with Front Panel and Software Level Meters for more details.
 
5. Keyboard Volume Control - Peripheral, Audio Output - These drop down menus set 
the hardware output to be controlled by the Mac keyboard’s volume control. First, 
select the hardware peripheral that includes the desired output using the Peripheral 
drop down, then select the specific audio output using the Audio Output drop down.
 
6. VBus- Apogee’s VBus creates virtual hardware buses to allow expanded routing of 
audio within one application or between different audio applications.
 
7. Performance Tuning - This drop down menu allows the adjustment of Symphony 
driver buffers to take advantage of the latest Intel Macs’ increased CPU power.
Set Performance Tuning to High Performance when using Symphony 64 on an Intel 
Mac. This reduces buffer sizes and ensures the lowest latency through the Symphony 
System.
Set Performance Tuning to Standard when software buffer settings won’t resolve 
clicking and popping issues.
Performance Tuning buffers are set in addition to the buffers typically found in digital 
audio applications. If audible clicks and pops are encountered during your session, 
first raise the driver buffer size in the audio application. If problems persist set 
Performance Tuning to Standard.
 
8. Symphony Source - This drop down menu selects the Symphony 64 card ports to 
be enabled for use. Ports that have a PC-32 connection to hardware interfaces should 
be enabled, while unconnected ports must NOT be enabled. For example, if 1 
Symphony I/O is connected to each port of one Symphony 64 card, set Symphony 
Source to PCI Card 1, Port 1-2 (Chs 1-64).

System Setup - Standalone Audio Interface Mode
When audio interface mode is set to Standalone, the following controls are displayed:
 
1. Clock Source - This drop down selects Symphony I/O's clock source. The following 

sources may be selected.
Internal - Symphony I/O is clocked from its internal crystal.
WC - Symphony I/O is clocked from an external word clock signal connected to the 
rear panel WC input.
Digital - Symphony I/O is clocked from a digital audio input. The digital clock sources 
listed in the drop down menu vary according to the digital audio inputs included on the 
installed I/O cards.
2. Sample Rate - When Clock Source is set the Internal, the unit's sample rate may be 

selected using this drop down. When the Clock Source is set to an external source, 
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the sample rate of the external source is displayed and the drop down is greyed 
out.

3. Peak Hold - This pop-up menu sets the time that peak indications are held on 
software and front panel meters.

4. Over Hold - This pop-up menu sets the time that over indications are held on 
software and front panel meters.

5. See Working with Front Panel and Software Level Meters for more details.

System Setup - Pro Tools HD Audio Interface Mode
When Audio Interface Mode is set to Pro Tools HD, most settings are made in Pro Tools.
 
1. Clock Source - To set clock source, choose Setup > Hardware in Pro Tools and set 

the Clock Source drop down.

2.  Sample Rate - The sample rate of a Pro Tools system is always set by the Pro Tools 
session, and may not be changed once set during session creation.

3.  Peak Hold - This pop-up menu sets the time that peak indications are held on 
software and front panel meters.

4. Over Hold - This pop-up menu sets the time that over indications are held on 
software and front panel meters.

See Working with Front Panel and Software Level Meters for more details.
 

Toolbar
The toolbar is reserved for system controls that must remain easily accessible.
 

 
1. Clear Meters - this button clears all held peak and over indications on all hardware 

and software meters.

2. System Status - this window displays the clock source, sample rate and system 
status of the currently selected system. A system status of “Ready” indicates that all 
detected units are properly connected and clocked. Please consult Troubleshooting 
or other system status messages.
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3. Toolbar Monitor Controls - These controls offer immediate access to one 
peripheral’s Speaker and headphone volume controls, regardless of the Devices 
sidebar selection. In the Monitor panel drop down, choose the peripheral to which 
your speakers and headphones are connected.

Menu Bar Menus

About Apogee Maestro - Choose this menu item to display version information for all 
the hardware and software elements that make up the Symphony I/O system.
Preferences - Choose this menu item to display Maestro’s Preference panel.
Check Launch Maestro automatically when connecting a device to launch Maestro 
when the Mac is started.
Check Display Pop-ups to display the Symphony I/O Pop-up on the Mac Desktop to 
show Speaker and Headphone Level adjustments.

Hide Apogee Maestro 2 - Choose this menu item to hide the Maestro application.
Hide Others - Choose this menu item to hide all other open applications.
Show All - If any open applications have been hidden, choose this menu item to reveal 
all open applications.
Quit Apogee Maestro 2 - Choose this menu item to quit Maestro.



Close - Choose this menu item to close the Preferences panel when opened.
Rescan - Choose this menu item to re-initialize the link between Maestro software and 
Apogee hardware connected to the Mac, in the case where the hardware is correctly 
connected and powered on but not detected in Maestro.

 
Minimize - Choose this menu item to minimize the Maestro window to the OS X Dock.
Zoom - Choose this menu item to maximize the size of the Maestro window.
Choose any of the currently active tabs to open the tab window. Type Command + 
number to open the tab window.

Help - Choose this menu item to open Maestro Help.
 



Connecting Your Symphony I/O System
This chapter describes how to make the various analog, digital and clock connections 
between the Symphony I/O, Apple Mac computers, and other analog and digital audio 
gear.
 

• I/O Module Connections
• Connecting Headphones
• Making Clock Connections
• Connecting to Symphony 64 and Mobile Cards
• Connecting to Pro Tools HD PCI Cards
• Connecting to an Apple Mac’s USB Port

Analog IN
The Analog IN connector is found on these IO Modules:
 

• 8 Analog I/O + 8 Optical I/O
• 8 Analog I/O + 8 AES I/O
• 16 Analog In + 16 Optical Out

• Connect analog line level inputs to the Analog IN DB-25 connector, using an Apogee 
AD8-IFC breakout cable or equivalent.
• To match the reference level of Symphony I/O with that of the connected device, set 
Analog Ref Level in the Maestro Input and Output tab windows. For example, when 
connecting analog inputs and outputs to a professional console, set Analog Ref Level 
to +4 dBu.
• Connect “Instrument” level instruments (such as keyboards) to the Analog IN DB-25 
connector using a DB-25 to 1/4” TRS breakout cable, and set Analog Ref level (in the 
Maestro Input tab window) to Variable.

Analog OUT
The Analog OUT connector is found on these IO Modules:
 

• 8 Analog I/O + 8 Optical I/O
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• 8 Analog I/O + 8 AES I/O
• 16 Optical In + 16 Analog Out

• Connect analog line level outputs to the Analog OUT DB-25 connector, using an 
Apogee DA8-IFC breakout cable or equivalent.
• Connect powered speakers to the Analog OUT DB-25 connector, channels 1-2 (or 
1-6 for 5.1 and 1-8 for 7.1 speaker configurations), using an Apogee DA8-IFC breakout 
cable or equivalent. Select the desired Speaker configuration in the Maestro Output tab 
window.

Optical IN
The Optical IN connector is found on these IO Modules:
 

• 8 Analog I/O + 8 Optical I/O
• 16 Optical In + 16 Analog Out

• Connect ADAT inputs to the S/PDIF-ADAT-SMUX In Toslink connectors.
• When using SMUX format devices (ADAT format at 88.2-96kHz sample rate), 
connect channels 1-4 to S/PDIF-ADAT-SMUX In and channels 5-8 to SMUX In.
• Connect S/PDIF optical inputs to the S/PDIF-ADAT-SMUX In Toslink connectors, 
and set Optical format (in Maestro’s Device Settings tab window) to S/PDIF.

Optical Out
The Optical Out connector is found on these IO Modules:
 

• 8 Analog I/O + 8 Optical I/O



• 16 Analog In + 16 Optical Out

• Connect ADAT outputs to the S/PDIF-ADAT-SMUX Out Toslink connectors.
• When using SMUX format devices (ADAT format at 88.2-96kHz sample rate), 
connect channels 1-4 to S/PDIF-ADAT-SMUX Out and channels 5-8 to SMUX Out.
• Connect S/PDIF optical Outputs to the S/PDIF-ADAT-SMUX Out Toslink 
connectors, and set Optical format (in Maestro’s Device Settings tab window) to 
S/PDIF.

AES In/Out
The AES In/Out connectors are found on these IO Modules:
 

• 8 Analog I/O + 8 AES I/O

• Connect AES inputs and outputs to the AES In/Out DB-25 connector, using an 
Apogee AES-IFC breakout cable or equivalent.



S/PDIF In/Out
The S/PDIF In/Out connectors are found on these IO Modules:
 

• 8 Analog I/O + 8 Optical I/O
• 8 Analog I/O + 8 AES I/O
• 16 Analog In + 16 Optical Out
• 16 Optical In + 16 Analog Out

 
• Connect S/PDIF coax inputs and outputs to the S/PDIF RCA connectors. Set S/PDIF 
Replaces and S/PDIF Mirrors (in Maestro’s Input and Output tab windows).

Mic Pre I/O Module
Mic Pre I/O Modules must be installed in the Card 2 (upper) slot in conjunction with one 
of the following I/O Modules:

• 8 Analog I/O + 8 Optical I/O
• 8 Analog I/O + 8 AES I/O
• 16 Analog In + 16 Optical Out

Connect mics to the Analog IN connector of the lower I/O Module. When an input's 
Analog Level is set to Mic (or Instrument) in Maestro, the signal is routed from the lower 



I/O Module's Analog IN connector, through gain circuitry in the Mic Pre I/O Module, and 
back to the lower I/O Module's A/D conversion stage.

Connect instruments to the rear panel INSTRUMENTS 1/4" connectors.

I/O Numbering with 2 IO Modules
When two IO Modules are installed, Card 1 (lower slot) inputs and outputs are 
numbered lower in Maestro software than Card 2 (upper slot) inputs and outputs. As an 
example, the



resultant numbering of inputs and outputs for 2 8 Analog I/O + 8 Optical I/O Modules 
are shown below.



I/O Module Connections - Standalone Audio Interface Mode
 
When Audio Interface Mode is set to Standalone, I/O Module inputs may be routed 
directly to outputs in order to use Symphony I/O's A/D and D/A conversion stages with 
other interfaces or standalone digital devices. A USB connection between Symphony I/
O and an Intel Mac provides the link between Apogee Maestro software and 
Symphony I/O, in order to make calibration, meter configuration, digital format and 
other settings. Once settings are made, the USB connection may be removed.
 
 
In Standalone audio interface mode its possible to connect Symphony I/O to a non-
Mac computer equipped with AES, Optical or S/PDIF Coax I/O (often provided by an 
optional PCI card). For example, to connect Symphony I/O to an ADAT-equipped 
WIndows computer, make the following connections.

Connecting Headphones

Connect headphones to Symphony I/O’s front panel  connectors. Set the source for 
each headphone output in Maestro’s Output Routing tab window.



Making Hardware Clock Connections
 
Symphony I/O provides several facilities for the connection of clock signals:

• Word Clock inputs and outputs - Use the word clock inputs and outputs for most 
clock connections to digital consoles, digital effects devices, or other digital audio 
devices equipped with standard word clock I/O.

• Loop Clock inputs and outputs - Use Loop clock inputs and outputs to lock 
together multiple Symphony I/Os in a computer-based digital audio workstation 
(DAW) such as Apogee's Symphony 64 PCI system. Symphony I/O's Loop clock 
is compatible with Avid Pro Tools Loop Sync, meaning that a Symphony I/O may 
be freely incorporated into a Pro Tools Loop Sync chain.

• Digital audio inputs and outputs - Use Symphony I/O's digital audio I/O to send 
and receive clock between Sympony I/O and digital devices that don't include 
work clock I/O. When using Symphony I/O in Standalone audio interface mode, 
the most convenient way to clock the connected digital device is through the 
digital audio input from Symphony I/O.

• The following clock connection information applies to all audio interface modes.
 
Locking External Devices to Symphony I/O
To lock external clock devices to a single Symphony I/O:

1. Connect the rear panel WC OUT to the word clock input of the device, using a 
BNC cable. Set the external device's clock source to Word Clock.

2. When connecting digital devices to Symphony I/O’s AES, ADAT/SMUX or S/PDIF 
outputs, clock is transmitted with the digital connection, allowing the receiving 
device to simply clock to its digital input.

 
1 SIO WC out to device WC in, device set to WC clock

Locking Symphony I/O to External Devices
To lock a single Symphony I/O to external devices such as a Master clock:



1. Connect a BNC cable between the device's word clock output and Symphony I/
O’s WC IN.

2. If no other devices are to be connected, press in the rear panel termination (WC 
Term) switch. 

3. To lock Symphony I/O to a digital input, connect the source's digital output to 
Symphony I/O digital input.

1 SIO WC in to device WC out, SIO set to WC clock

Once clock connections are made, see Setting the Clock Source to complete the 
process. Note that software settings may vary based on the audio interface mode.
 
Locking multiple Symphony I/Os with Loop Clock
When multiple Symphony I/Os are used together in a digital audio system (for example 
with a Symphony 64 or Avid Pro Tools HD PCI card), use the rear panel Loop 
connections to lock the Symphony I/Os together, as described below:
 
Using a BNC cable, connect the Loop Out of unit 1 to the Loop In of unit 2. With 
additional BNC cables, connect the Loop Out of each unit to the Loop In of the next 
unit until all units are connected. Finally, connect the Loop Out of the last unit to the 
Loop In of the first unit. Please consult the diagram below for an example connection.

http://support.apogeedigital.com/help/symphony-io/pgs/configuring_clock.html
http://support.apogeedigital.com/help/symphony-io/pgs/configuring_clock.html


Locking multiple Symphony I/Os to External Devices
To lock multiple Symphony I/Os to external devices such as a master clock, first 
connect Loop Clock as shown above. Then connect a BNC cable between the 
device's word clock output and one Symphony I/O’s WC In. Configure this Symphony I/
O as the Loop Master as described in Setting the Clock Source.

Connecting to a Symphony 64 PCIe Card
 

http://support.apogeedigital.com/help/symphony-io/pgs/configuring_clock.html
http://support.apogeedigital.com/help/symphony-io/pgs/configuring_clock.html


Symphony Audio Interface Mode

 
When Audio Interface Mode is set to Symphony, one (1) Symphony I/O with up to 32 
channels of input and output may be connected to each port of a Symphony 64 PCI 
card.
Connect one end of an Apogee PC-32 cable (supplied with the PCI card) to the first 
Symphony I/O Main port and the other end to the Symphony 64's Channels 1-32 port. 
Connect a second PC-32 cable to the second Symphony I/O Main port and the other 
end to the Symphony 64's Channels 33-64 port. See the diagram below.

IMPORTANT - Once all PC-32 connections are made, open Maestro 2, click on the 
System Setup and enable all connected Symphony 64 ports using the Symphony 
Source drop down. For example, if interfaces are connected to both the Symphony 64 
card's "Channels 1-32" and "Channels 33-64" ports, set Symphony Source to PCI Card 
1, 
Port 1-2 (Chs 1-64).
 
Connecting to a Symphony Mobile Card
When Symphony I/O's Audio Interface Mode is set to Symphony, up to 32 channels of 
Symphony I/O input and output may be connected to a Symphony Mobile PCI card.
Connect one end of an Apogee PC-32 cable (supplied with the PCI card) to the 
Symphony I/O Main port and the other end to the Symphony Mobile card, as shown 
below.



PC-32 cable lengths of up to 30 meters between the Mac and Symphony I/O are 
supported at sample rates of 44.1-96 kHz. Lengths up to 5 meters are supported at 
sample rates of 176.4-192 kHz.



Connecting to Pro Tools HD PCI Cards
 

Pro Tools HD Audio Interface Mode

 
Connecting to Pro Tools HD PCI cards
 
When Symphony I/O's Audio Interface Mode is set to Pro Tools HD, one (1) Symphony 
I/O with up to 32 channels of input and output may be connected to each Pro Tools HD 
PCI card. Up to 3 Symphony I/Os may be connected.
Connect one end of an Apogee PC-32 (or Avid DigiLink) multichannel cable to the 
Symphony I/O Main port and the other end to a Pro Tools HD PCI Core card, as shown 
below. Connect additional Symphony I/Os to additional HD PCI cards.
 
The following Pro Tools HD PCI cards are supported.

• HD Core
• HD Process
• HD Accel PCI
• HD Accel Core
• HD Accel PCIe
• HD Native (see below)



Connecting to Pro Tools HD Native cards
 
When Symphony I/O's Audio Interface Mode is set to Pro Tools HD, one (1) Symphony 
I/O with up to 32 channels of input and output may be connected to each port of a Pro 
Tools HD Native PCI card. Connect one end of an Apogee PC-32 (or Avid DigiLink) 
multichannel cable to the Symphony I/O Main port and the other end to Port 1 of the 
HD Native PCI Core card. Connect a second Symphony I/O to Port 2.
 
PC-32 cable lengths of up to 30 meters between the Mac and Symphony I/O are 
supported at sample rates of 44.1-96 kHz. Lengths up to 5 meters are supported at 
sample rates of 176.4-192 kHz.

Symphony I/O Release 3 - The connection of one Symphony I/O per Pro Tools HD Core 
(or HD Accel Core) is currently supported. The connection of multiple units, including 
Avid 192 I/Os, X-HD-equipped AD16Xs, DA16Xs and Rosettas, will be supported in a 
future Symphony I/O update.
 
Apogee Maestro Software Control via USB
 
A USB connection between Symphony I/O and an Intel Mac provides the link between 
Apogee Maestro software and Symphony I/O. See Connecting to a Mac's USB Port for 
details.

Connecting to a Mac’s USB Port
 

http://support.apogeedigital.com/help/symphony-io/pgs/connecting_usb.html
http://support.apogeedigital.com/help/symphony-io/pgs/connecting_usb.html


Using a standard Type A - Type B USB cable, connect Symphony I/O's USB port to an 
Apple Intel Mac USB port. Ensure that the cable is certified for USB 2.0 operation.

Symphony Audio Interface Mode

When Audio Interface Mode is set to Symphony PCI, the USB port is used for updating 
firmware only. See Updating Firmware for details.
 

Pro Tools HD Audio Interface Mode

When Audio Interface Mode is set to Pro Tools HD, a USB connection between 
Symphony I/O and an Intel Mac provides the link between Apogee Maestro software 
and Symphony 
I/O, in order to make calibration, meter configuration, digital format and other settings.
Symphony I/O's clock source and sample rate are set from Pro Tools software, and 
don't require the USB connection. The USB connection is only required to make 
Maestro settings, and may be removed once settings are complete. Note that the audio 
and USB connections don't have to be made to the same computer, allowing 

http://support.apogeedigital.com/help/symphony-io/pgs/hardware_firmware.html
http://support.apogeedigital.com/help/symphony-io/pgs/hardware_firmware.html


Symphony I/O to be connected to Pro Tools HD cards installed in Apple Mac G5 or 
Windows computers while running Maestro on an Apple Intel Mac.

Standalone Interface Mode

When Audio Interface Mode is set to Standalone, a USB connection between 
Symphony 
I/O and an Intel Mac provides the link between Apogee Maestro software and 
Symphony 
I/O, in order to make calibration, meter configuration, digital format and other settings.
Symphony I/O's clock source and sample rate may be set using the front panel 
encoders, and don't require the USB connection. The USB connection is only required 
to make Maestro settings, and may be removed once settings are complete.

Note that the audio and USB connections don't have to be made to the same 
computer, allowing Symphony I/O's Optical or AES I/O to be connected to an Windows 
computers while USB is connected to an Apple Intel Mac.
 



Configuring Your Symphony I/O System
This chapter describes how to initially set up Symphony I/O and Maestro to 
accommodate your working preferences.
 

• Setting the Audio Interface Mode (AIM)
• Navigating In Maestro
• Setting the Clock Source
• Setting the Sample Rate
• Configuring Speaker and Headphone Outputs
• Configuring Digital I/O formats
• Calibrating Symphony I/O

 

Audio Interface Mode (AIM)
The Audio Interface Mode adapts Symphony I/O’s hardware and software interface to 
the primary host system (the DAW or hardware device) that you’re recording with. 
The following Audio Interface Modes, described below, are available with the latest 
Symphony I/O firmware and software release:
 

Symphony - to connect to Symphony 64 PCI and Symphony Mobile Express/34 cards.

Pro Tools HD - to connect to Pro Tools HD PCI cards. Symphony I/O may be controlled 
from a Mac via USB, though the Mac connection isn’t required for audio operation.

Standalone - to connect Symphony I/O to recording devices and other host systems 
via ADAT, S/PDIF or AES inputs and outputs. Symphony I/O may be controlled from a 
Mac via USB, though the Mac connection isn’t required for audio operation.
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Setting the Audio Interface Mode
To set the Audio Interface Mode, press and hold the front panel right-hand encoder. 
The currently selected Audio Interface Mode is shown on the OLED in solidly 
illuminated text. Select the desired Audio Interface Mode by turning the right-hand 
encoder - inactive Audio Interface Modes are shown in flashing text. Once the desired 
Audio Interface Mode is shown, press the right-hand encoder to confirm the selection. 
Symphony I/O will re-boot in the new Audio Interface Mode.
 
The currently selected Audio Interface Mode is also indicated in Maestro's Device 
Settings tab. When connecting multiple Symphony I/Os to Symphony or Pro Tools PCI 
cards, be sure set the Audio Interface Mode on each unit first.
 
Parameter Storage between Audio Interface Modes
When switching between Audio Interface Modes, all settings are saved independently 
for each mode. For example, it's possible to configure different routing for Symphony 
and Standalone audio interface modes and freely switch between them using the front 
panel control described above. Note that calibration settings for are saved 
independently for each audio interface mode.



Symphony Audio Interface Mode

 
Symphony I/O has been designed to seamlessly interface with the Symphony 64 and 
Symphony Mobile PCI cards. All audio and control data is transmitted via Apogee 
PC-32 cables (included with the Symphony 64 or Mobile card).

When Audio Interface Mode is set to Symphony, the basic signal flow of Symphony I/O 
is shown below.



Pro Tools HD audio interface mode

 
Symphony I/O may connect directly to Pro Tools HD Core, Accel Core and Accel PCI 
cards, using Apogee PC-32 or Avid DigiLink cables. Digital audio and clock 
configuration data, such as the session sample rate and hardware clock source, is 
transmitted via the PC-32 cable (referred to as a DigiLink cable in Pro Tools 
documentation). Software control data between Symphony I/O and Apogee Maestro 
software is transmitted via a USB connection.
 
Connect Symphony I/O's USB port to a USB port on your Apple Mac to set these 
parameters in Maestro:

• Calibration
• Meter Configuration
• Digital I/O format
• Mic Pre settings such as phantom power, high pass (if a Mic Pre I/O Module is 

installed)

Once settings have been completed, USB may be disconnected, as it's not required 
for operation with Pro Tools.
 
These Symphony I/O parameters may be set using the front panel encoders:

• Speaker and Headphone Output Levels;
• Mic Pre Input gain (if a Mic Pre I/O Module is installed).

These parameters are set from Pro Tools software:
• Clock Source and Sample Rate;
• Audio routing.

 



When Audio Interface Mode is set to Pro Tools HD, the basic signal flow of Symphony I/
O is shown below.



Standalone Interface Mode

 
In the case where the digital host system isn't computer-based (or is a computer-based 
system that interfaces with Symphony I/O using standard digital I/O such as AES or 
Optical), Symphony I/O's Standalone mode offers the ability to route any I/O Module 
input to any I/O Module output. The most common Standalone application is the use of 
Symphony I/O as a standalone A/D - D/A converter, where analog inputs are routed to 
the I/O Module's AES or Optical outputs and AES or Optical inputs are routed to analog 
outputs. Software control data between Symphony I/O and Apogee Maestro software is 
transmitted via a USB connection.Connect Symphony I/O's USB port to a USB port on 
your Apple Mac to set these parameters in Maestro:

• Calibration
• Meter Configuration
• Digital I/O format
• Mic Pre settings such as phantom power, high pass (if a Mic Pre I/O Module is 

installed)

Once settings have been completed, USB may be disconnected, as it's not required 
for Standalone operation.These Symphony I/O parameters may be set using the front 
panel encoders:

• Sample rate and clock source
• Speaker and Headphone Output Levels;
• Mic Pre Input gain (if a Mic Pre I/O Module is installed).

When Audio Interface Mode is set to Standalone, the basic signal flow of Symphony I/O 
is shown here.



Navigating in Maestro
This section describes how to navigate the Maestro application, identify hardware 
peripherals and locate settings.
 
Once all hardware connections are made and Audio Interface Mode has been set on 
each hardware unit, launch Maestro software by double-clicking on the Apogee 
Maestro icon found in your Mac’s Applications folder.

Devices Sidebar
When navigating in Maestro for the first time, start at the Devices sidebar, on the left 
hand side of the Maestro window. All the Apogee devices connected to your Mac are 
displayed in Maestro’s Devices sidebar, organized by the System (such as Symphony, 
USB or Firewire) and the Apogee hardware peripherals that make up each system. 
When a Symphony System is installed, the Symphony PCI cards appear in the sidebar 
but aren’t selectable. In the sidebar, click on a peripheral to display a row of settings 
for that device in the Main area, under the Settings tabs. Shift-click or Option-click 
Peripherals to display one row each for multiple hardware devices.

ID Button
To the left of each row of settings, a peripheral icon plus ID button appears. Clicking on 
the ID button illuminates the front panel meters of the associated peripheral, making a 
visual connection between the software settings row and the hardware unit. When 
multiple rows are displayed, the ID button helps to clarify which settings belongs to 
which unit.

Peripheral Prefix
By assigning a unique letter prefix to each peripheral (using the Peripheral Prefix drop 
down in the Device Settings tab), peripheral labels throughout Maestro and in audio 
software may be easily associated with the hardware unit. It’s recommended to assign 
prefixes to peripherals in the order A,B,C,D etc, but any letter may be assigned to any 
peripheral.
 



Settings Tabs
Once a peripheral is selected in the Devices sidebar, settings for that peripheral are 
displayed in the Main area, under the tab selection. In the case of Symphony I/O, 
settings are distributed amongst the following tabs:

• Input - settings pertaining to I/O Module analog and Digital Inputs are displayed in 
this tab.

• Output - settings pertaining to I/O Module analog and Digital Outputs are displayed 
in this tab.

• Device Settings - miscellaneous peripheral settings such as front panel meter 
assignment are displayed in this tab.

• Routing - When Audio Interface Mode is set to Symphony PCI, the Routing tabs 
display the inputs and outputs of the Symphony 64 card, where routing between 
hardware and software is performed. While the Input, Output and Device Settings 
tabs display peripheral settings, the Routing and Mixer tabs display Symphony 64 
card settings. When the Routing or Mixer tabs are selected, a yellow “halo” in the 
Devices sidebar indicates this by encircling the Symphony 64 card and the attached 
peripherals.

• System Setup - Global settings pertaining to the entire Symphony System, including 
all Symphony 64 PCI cards and attached peripherals, are displayed in this tab. A 
yellow “halo” in the Devices sidebar encircles all the devices belonging to the 
system. Settings found in this tab include Clock Source, Sample Rate and Global 
Meter characteristics.
 



Setting the Clock Source
Setting the Clock Source is one of the first steps when configuring your Symphony I/O 
system. Depending on the Audio Interface Mode, the Clock Source may be set from 
Symphony I/O’s front panel, from Maestro’s System Setup tab, or from Audio MIDI 
Setup. See specific instructions for each Audio Interface Mode below:
 

Symphony Audio Interface Mode

 
When Audio Interface Mode is set to Symphony, the following instructions apply:
 
To set clock source from Symphony I/O’s front panel:
1. Press and hold the left hand encoder until the current clock source is shown on the 

OLED Display.

2. Turn the left hand encoder to select the desired clock source.

3. When selecting Digital, turn the right hand encoder to select the specific digital inp
¡ut to be used as the clock source.

4. Click either encoder to confirm the new clock source selection.

To set clock source from Maestro software.
1. Click the System Setup tab

Choose the desired entry in the Clock Source drop down menu

2. To set clock source in Audio MIDI Setup:
• Choose Window > Show Audio Window if the Audio Devices list isn’t visible.
• Click on Symphony 64 in the left hand devices list.
• Select the desired source in the Clock Source drop down menu
 
 



Standalone Audio Interface Mode

 When Audio Interface Mode is set to Standalone, the following instructions apply:
 
To set clock source from Symphony I/O’s front panel:

1. Press and hold the left hand encoder until the current clock source is shown on 
the OLED Display.

2. Turn the left hand encoder to select the desired clock source.
3. When selecting Digital, turn the right hand encoder to select the specific digital 

input to be used as the clock source.
4. Click either encoder to confirm the new clock source selection.

To set clock source from Maestro software.
1. Click the System Setup tab
2. Choose the desired entry in the Clock Source drop down menu.

Pro Tools HD Audio Interface Mode

 
When Audio Interface Mode is set to Pro Tools HD, the following instructions 
apply:
 
Clock source and sample rate are set in Pro Tools software and transmitted to 
Symphony I/O via the PC-32 (or DigiLink) connection. For the most compatible 
operation with Pro Tools software, it is not possible to set clock source or sample rate 
from Maestro or from Symphony I/O's front panel when Audio Interface Mode is set to 
Pro Tools HD.
 
To set Symphony I/O's clock source from Pro Tools software:
 
In Pro Tools, choose Setup > Hardware (Clock Source may also be set from Setup > 
Session when a Pro Tools session is open).



In the Clock Source drop down menu, select the desired source:

• To lock Symphony I/O to its Internal Clock Source, select Internal in Pro Tools' Clock 
Source drop down menu. If a single Symphony I/O is detected as 2 192 I/Os, either 
192 I/O drop down menu may be used.

• To lock Symphony I/O to its Word Clock Input, select Word Clock (sample rate) in Pro 
Tools' Clock Source drop down menu, where sample rate equals the actual rate of the 
session. When the session is running at sample rates of 88.2-192kHz, a second word 
clock entry at the base rate of 44.1-48kHz is found in the Clock Source menu - this is 
not a valid selection.

• To lock Symphony I/O to a Digital Input, please consult the charts below that indicate 
valid Pro Tools software clock sources according to the I/O Module combination 
installed in your Symphony I/O and the sample rate of the session. To avoid the 
complicated correspondance between Pro Tools Software Clock selections and 
Symphony I/O Hardware Clock Inputs, it's suggested to lock Symphony I/O to 
Internal or Word Clock!

Pro Tools Clock Source
The following charts show, for each I/O Module combination at the three sample rate 
ranges, valid Pro Tools Clock Source selections and the resulting Symphony I/O clock 
source employed. For example, when 2 8 Analog + 8 Optical I/O Modules are installed, 
and you wish to lock to S/PDIF Optical 3-4 (the first optical input on the top I/O 
Module):

1. In Maestro, set Optical Format Card 2 to S/PDIF.
2. In Pro Tools' Hardware Setup > Main tab, set Digital Format to Optical (S/PDIF).
3. Select 192 I/O#2 > Optical (S/PDIF), as indicated in the 2 8 Analog + 8 Optical I/
O chart.

Please refer to the online version of this Users Guide for Pro Tools Clocking Charts.
http://support.apogeedigital.com/help/symphony-io/
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Setting the Sample Rate
 
Symphony Audio Interface Mode

 
When Symphony I/O is connected to a Symphony 64 PCI card, the Core Audio driver 
(part of the OS X operating system) sets the sample rate of the hardware system, 
including the Symphony I/O. Audio applications such as Apple Logic, in turn, set the 
Core Audio sample rate.
 
It’s important to note that when Symphony I/O is clocked to an external source, the 
sample rate of the external source must be set to match the Core Audio sample rate. 
For example, if Symphony I/O is locked to an Apogee Big Ben Master Clock, be sure to 
set Big Ben’s sample rate to the same rate as your DAW audio application session.
 

Standalone Audio Interface Mode

 
When Audio Interface Mode is set to Symphony, the following instructions apply:
 
To set sample rates from Symphony I/O’s front panel:

1. Press and hold the left hand encoder until the current clock source is shown on 
the OLED Display.

2. Turn the left hand encoder and select INTernal.
3. Turn the right hand encoder to select the desired sample rate.
4. Click either encoder to confirm the new clock source selection.

To set clock source from Maestro software.
1. Click the System Setup tab
2. Set Clock Source to Internal.
3. Choose the desired sample rate in the Sample Rate drop down menu.

 



Pro Tools HD Audio Interface Mode

 
When Symphony I/O is connected to Pro Tools HD cards, the sample rate is set in Pro 
Tools software when creating a session. Once a session is created at a specific sample 
rate, it can't be changed from that rate.
 
It’s important to note that when Symphony I/O is clocked to an external source, the 
sample rate of the external source must be set to match the Pro Tools session sample 
rate. For example, if Symphony I/O is locked to an Apogee Big Ben Master Clock, be 
sure to set Big Ben’s sample rate to the same rate as your Pro Tools session.

Configuring Speaker and Headphone Outputs

Configuring Speaker Output
When connecting Symphony I/O’s analog outputs to powered speakers (or a power 
amp and passive speakers), set the Speaker Out drop down menu in Maestro's Output 
tab window to match the speaker set-up employed.
 
The following settings are available:

• Line - All analog outputs are set to Line level, as defined by the Analog and 
Digital Reference settings.

• Stereo (1-2) - Choose this setting when connecting a stereo set of speakers to 
analog outputs 1 and 2. Analog outputs 3-8 operate as standard line outputs.

• 5.1 (1-6) - Choose this setting when connecting a 5.1 set of speakers to analog 
outputs 1 through 6. Analog outputs 7-8 operate as standard line outputs.

• 7.1 (1-8) - Choose this setting when connecting a 7.1 set of speakers to analog 
outputs 1 through 8. All analog output levels are controlled by hardware and 
software level controls.

Once set, speaker output levels may be controlled from a wide variety of hardware and 
software controls, as described in Setting Speaker and Headphone Output Levels.
 
Configuring Headphone Outputs
The headphone outputs may be set to mirror any I/O Module hardware output, using 
the HP1 andHP2 drop down menus found in Maestro’s Output tab window.
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Configuring Digital I/O Formats

Setting the Optical I/O Format
When using an optical I/O Module, set the format of the optical inputs and outputs to 
either ADAT-SMUX or S/PDIF using the Optical Format drop down menu, found on the 
Device Settings tab. The following format selections are available:

ADAT - This format transmits 8 channels of digital audio over one Toslink (optical) 
cable at sample rates of 44.1 to 48 kHz. The ADAT format, originally found on Alesis 
ADAT digital recorders, is found on a wide array of digital devices such as keyboards, 
audio PCI cards and audio interfaces.
 
SMUX - This format transmits 8 channels of digital audio over 2 Toslink cables at 
sample rates of 88.2kHz to 96kHz. The SMUX format,an extension of the ADAT format, 
allows the transmission of digital audio data at higher sample rates.
 
S/PDIF - This format transmits 2 channels of digital audio over 1 Toslink cable at 
sample rates of 44.1kHz to 96kHz. S/PDIF optical format connections are often found 
on keyboards, CD players and other consumer audio devices.
 
Using the S/PDIF Coax I/O
The S/PDIF Coax format transmits 2 channels of digital audio over 1 coaxial cable at 
sample rates of 44.1 to 192 kHz. S/PDIF Coax format connections are found on audio 
PCI cards, audio interfaces, digital effects units and CD players.
 
S/PDIF Coax Input
Symphony I/O’s internal architecture employs 16 channels of input and output per I/O 
Module. Since the S/PDIF Coax Inputs are the 17th and 18th inputs, it’s necessary to 
replace a stereo pair of analog or digital inputs with the S/PDIF Coax Input in order for 
the S/PDIF Coax Input to appear on the Routing tab grid. Use the S/PDIF Coax 
Replaces drop down menu, in Maestro's Input tab, to select the analog or digital input 
pair to be replaced by the S/PDIF Coax Input pair.

S/PDIF Coax Output
The S/PDIF Coax Output is "tapped" from one of the other analog or digital stereo 
output pairs. Use the S/PDIF Coax Mirrors drop down menu, in Maestro's Output tab, 
to choose which analog or digital stereo output pair will be duplicated on the S/PDIF 
Coax Output.

Calibrating Symphony I/O
Symphony I/O’s A/D and D/A converters may be calibrated to operate at optimum 
levels with a wide variety of analog gear. The calibration process is performed in the 
following three steps:

1. Choose Analog Input and Output Reference Levels
2. Choose Digital Input and Output Reference Levels



3. Adjust Input and Output Trims.
 
Step 1 - Choose the Analog Reference Levels
Set Analog Reference to match the nominal operating level of connected analog 
equipment. Consult the operating instructions of the equipment to determine its 
nominal operating level.
 
The following settings are available:

+4 dBu - Choose this setting when connecting to professional audio gear that 
operates at a nominal level of +4 dBu. As a general rule, high-end mic preamps, 
professional mixing consoles and tape machines operate at +4 dBu nominal level.
-10 dBV - Choose this setting when connecting to semi-pro or consumer gear such 
as home stereos and “project” studio equipment.
Variable - Choose this setting when a precise nominal level setting isn’t necessary. 
For example, the operating level of electronic instruments may greatly vary from 
model to model; by choosing Variable, it’s easy to obtain a satisfactory input level 
without a lot of fuss.

When connecting Symphony I/O’s Inputs and outputs to the same device (for example, 
a mixing console), it’s best to set the analog output reference level (in Maestro’s 
Output tab window) to the same setting as the input reference level, to preserve unity 
gain.
 
 
Step 2 -Choose the Digital Reference Levels
The Digital Reference Level determines the amount of headroom before digital overs 
occur, and is set according to user preference. As a general rule, the more 
unpredictable the audio source being recorded, the lower the Digital Reference should 
be set in order to maximize headroom. For example, when recording musical content 
with unpredictable peaks, set Digital Reference to -18 or -20 dBFs. When recording an 
automated mix, where dynamic range is both carefully managed and peaks are 
predictable, a higher Digital Reference (around -14 to -12 dBFs) may be preferable.
 
Again, it’s best to set the Digital Output Reference level at the same setting as the 
Digital Input Reference level, to preserve unity gain through the system.
 
 



Step 3 - Adjust Trims
When interfacing even the highest quality analog gear, slight level adjustments are 
necessary to ensure that each channel’s actual gain equals the theoretical gain based 
on the analog and digital references selected. Follow these steps to trim each channel:

1. Click Show Trims on the Input and Output tabs to expose trim faders for each 
analog channel.

2. Connect a 1kHz sine wave to an A/D channel at a level equal to the selected analog 
reference (for example, +4 dBu).

3. Adjust the channel’s Input trim fader until the actual digital level, as displayed in the 
Meter Level Readout, is equal to the selected digital reference.

4. To calibrate the D/A, route a 1kHz sine to a D/A channel at a level equal to the 
selected digital reference. Most digital audio workstations offer a Test Generator 
function to generate a sine wave at a specified digital level. 

5. Adjust the channel’s Output trim fader until the signal reads +4dBu (or the selected 
Output analog reference) using an external meter. If using a standard volt-
ohmmeter, set it to read AC Volts, and adjust the trim until a voltage of 1.228 is read. 
Note that on the Output tab, the Meter Level Readout is pre-Trim, so that 
adjustments to the Trim fader aren't reflected in the level displayed.



Configuring Audio Software
This chapter describes how to set up and configure your audio software
 

Mac Settings
Apple Logic Settings
Apple GarageBand Settings
Avid Pro Tools Settings

Configuration Settings on your Mac

Mac Sound Dialog
Once you’ve installed Symphony I/O software and restarted your Mac, the dialog box 
shown below appears. Click Yes to use Symphony I/O for sound input and output for 
applications such as iTunes, Quicktime and other audio utilities.
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Configuration Settings in OS X Audio MIDI Setup
Symphony I/O may be selected for Mac Sound I/O in Audio MIDI Setup.

1. To open Audio MIDI Setup, choose Applications > Utilities > Audio MIDI Setup.
2. In AMS, choose Window > Show Audio Window.
3. In the left hand Devices column, select Symphony 64.
4. Set Clock Source to the desired source.
5. Ensure that Source is set to PC Card 1, Port 1 (Chs 1-32).
6. Set Format to the desired sample rate. If Logic Pro is open, the sample rate of 

the session overrides the Format setting.

 



Configuration Settings in OS X Sound Preferences
Symphony I/O may be selected for Mac Sound I/O in the OS X Sound Preferences.
 

1. Choose Apple > System Preferences and click Sound.
2. Click Output.
3. Select Symphony64: PCI Card 1, Port 1 (Chs 1-32).
4. Click Input.
5. Select Symphony64: PCI Card 1, Port 1 (Chs 1-32).



Configuration Settings in Apple Logic Pro
 
The following steps describe how to configure Symphony I/O with Apple Logic Pro.

1. Open Logic Pro 9 and choose Logic Pro > Preferences > Audio. 
2. In the Preferences window, select the Devices tab, then the CoreAudio tab. 
3. Select Symphony 64 in the Device drop down menu. 
4. Set I/O Buffer Size to 32 for the lowest latency, or to 64 for more DSP resources 

in Logic (inputs, outputs, plug-ins).
5. Click on Apply Changes.

* The I/O Buffer Size, found in the Logic Pro preference window described above, and 
the Performance Tuning setting, found in the Apogee Maestro software, are the two 
settings that determine the audio latency through your Symphony system. When using 
Symphony 64 and a Mac Pro, verify that Performance Tuning is set to High 
Performance. The I/O Buffer Size should be set as low as possible without causing 
digital audio artifacts such as clicks and pops.
 
By selecting Symphony I/O input and output labels in Logic, the labels you see in 
Logic’s Channel Strip input and output slots correspond exactly to Symphony I/O’s 
hardware inputs and outputs, making I/O assignment much easier.



1. In Logic, choose Options > Audio > I/O Labels.
2. Select the labels in the Provided by Driver column.
3. Close the IO Labels window.



Configuration Settings in Apple GarageBand
 

1. In GarageBand, choose GarageBand > Preferences.
2. In the Preferences pane, click Audio/MIDI.
3. Select Symphony64 in the Audio Output and Audio Input drop down menus.

4. Show the Track Info pane by double-clicking the track icon, then click Real 
Instrument.
5. At the bottom of the pane, set the Input Source to the desired Symphony I/O 
input (or input pair).
6. Set Monitor to On.

 



Configuration Settings in Avid Pro Tools 
 
The following instructions describe the use of Symphony I/O with Pro Tools HD and HD 
Native PCI cards.
 
When working with Pro Tools software and Symphony I/O, it may be helpful to keep in 
mind the following principles of operation.
Each installed I/O Module is detected in Pro Tools' Hardware Setup as an Avid 192 I/O 
interface, and transmits and receives 16 channels of audio (12 channels @ 
176.4-192kHz)) with the Pro Tools HD PCI card.
When 1 I/O Module is installed (or 1 I/O Module plus a Mic Pre Module), Symphony I/O 
is detected as 1 192 I/O, providing 16 bi-directional audio channels.
When 2 I/O Modules are installed, a single Symphony I/O is detected as 2 192 I/Os, 
providing 32 bi-directional audio channels (as shown below).
Symphony I/O's clock source is set from Pro Tools software, while Symphony I/O's 
sample rate is set by the Pro Tools session.
Any other Pro Tools hardware commands (mostly in the Hardware Setup Window) are 
ignored by Symphony I/O.
Other Symphony I/O settings, such as levels and formats, are made in Apogee Maestro 
software, which communicates with Symphony I/O via the USB connection. Symphony 
I/O is detected in Apogee Maestro as a USB device.
Once Symphony I/O has been connected to a Pro Tools HD PCI card (see Connecting 
to Pro Tools HD PCI Cards), open the Pro Tools application.
 
Hardware Setup
 
Pro Tools' Hardware Setup is normally used to set the format of the 192 I/O's hardware 
inputs and outputs and route 16 selected inputs and outputs to the Pro Tools PCI card. 
Since Symphony I/O has a different set of hardware inputs and outputs, it ignores most 
settings in the Hardware Setup Window. The steps below ensure that the greatest 
number of channels to the PCI card are available at all sample rates. This may result in 
a mismatch between the digital format shown in Hardware Setup and the format of the 
digital I/O actually installed in your Symphony I/O, but this mismatch has no 
consequence on the transmission of digital audio.

1. Choose Setup > Hardware.
2. In the Peripherals pane, select each 192 I/O interface detected and perform 

steps 3 and 4.
3. Click the Digital tab, then set Input Format to AES. Uncheck any Sample Rate 

Conversion boxes.
4. Click the Main tab, then click "Set To Default".
5. When configuring a 16 Analog In I/O Module, set Inputs 9-10 through 15-16 to 

Analog 9-10 through Analog 15-16.
6. When configuring a 16 Analog Out I/O Module, set Outputs 9-10 through 15-16 

to Analog 9-10 through Analog 15-16.
7. Under Port Settings, ensure that the Expansion I/O radio button is clicked .
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8. Once steps are complete, Symphony I/O's analog I/O is routed identically that of 
an Avid 192, ensuring complete compatibility with Pro Tools Delay 
Compensation.

 
Symphony I/O's digital inputs and outputs are also routed as those of a 192 I/O, with a 
few exceptions based on the I/O Module installed:

1. When using an 8 Analog + 8 Optical I/O Module, Symphony I/O's optical I/O is 
listed as AES I/O. This has no effect on the actual audio signal.

2. When using a 16 Analog In + 16 Optical Out Module, the first 8 optical outputs 
are listed as analog outputs in Pro Tools and the second 8 optical outputs are 
listed as AES outputs. This has no effect on the actual audio signal. Delay 
compensation values applied to the first 8 optical outputs are longer than 
required.

3. When using a 16 Analog Out + 16 Optical In Module, the first 8 optical inputs 
are listed as analog inputs in Pro Tools and the second 8 optical inputs are listed 
as AES inputs. This has no effect on the actual audio signal. Delay 
compensation values applied to the first 8 optical inputs are longer than 
required.

The Hardware Setup Clock Source drop down menu is used to select the clock source 
for the Loop Master Interface, as described in Setting the Clock Source.
 
I/O Setup
 



Pro Tools' I/O Setup window is used to route 16 channels of hardware I/O per interface 
to Pro Tools software channel I/O.

1. Choose Setup > I/O and click the Input tab.
2. Delete all paths by Option-clicking the audio paths column on the left side of the 

window, then click Default.
3. Click the Output and Insert tabs and repeat step 2.
4. Once you've grasped audio routing between Symphony I/O and Pro Tools 

software using the I/O Setup default labels (as charted below for each I/O 
Module combination), it's suggested to modify the labels to more closely 
correspond with the actual inputs and outputs on connected Symphony I/Os. 
For example, if an 8 Analog + 8 Optical and an 8 Analog + 8 AES module were 
installed in a Symphony I/O, the labels in the I/O Setup window should be 
modified as shown below.



Audio Routing Between Symphony I/O and Pro Tools
 
Routing between Symphony I/O and Pro Tools software is charted below for each I/O 
Module combination. Note that the Input, Output and Insert tabs in Pro Tools' I/O Setup 
window must be reset to default as described above.

Please refer to the online version of this User’s Guide for Pro Tools Audio Routing 
Charts.
http://support.apogeedigital.com/help/symphony-io/
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Working with Your Symphony I/O System
This chapter describes the steps to accomplish several workflows commonly 
encountered in the modern digital production environment, using Symphony I/O and 
Apogee Maestro software. Many settings are duplicated on Symphony I/O’s front panel, 
in Maestro software, and even on your Mac itself, thus providing the flexibility to 
discover the working method that suits you best.
 

• Setting Speaker and Headphone Output Levels
• Using Soft Limit
• Working with Front Panel and Maestro Meters
• Working with VBus

Setting Speaker and Headphone Output Levels
Between the front panel encoders, level controls in Maestro, and Mac hardware and 
software level controls, there are several ways to control speaker and headphone 
output levels.
 
Front Panel Encoders
By default, the front panel OLED Display presents the necessary controls to select an 
output and set its audio level.
Once Symphony I/O has completed its power-up sequence, turn the left hand encoder 
to select the speaker outputs, headphone output 1 or headphone output 2.
Turn the right hand encoder to set the audio level. The audio level is expressed in dBs 
of attenuation from full level, i.e “-20 dB”.

Mute the speaker and headphone outputs simultaneously by pressing the right hand 
encoder.
 
Maestro Level Controls
Speaker and headphone output level controls of each peripheral may be controlled 
from knobs in the Output tab window.
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Speaker and headphone output knobs found in the Toolbar offer immediate access to 
the level controls of a selected peripheral, regardless of the Devices sidebar or tab 
selections. By selecting the peripheral to which your speakers are connected, you can 
quickly adjust output levels without the need to display that peripheral's Output tab 
window.

Mac Keyboard
Follow these steps to use your Mac’s keyboard volume and mute keys to control 
Symphony I/O output levels.

1. In OS X’s System Preferences > Sound, select Symphony 64 as the device for 
sound output.
2. In Maestro's System Setup Tab window select the Symphony I/O to be controlled 
in the Keyboard Volume Control > Peripheral drop down menu.
3. Select the specific output in the Audio Output drop down menu.

 
As an example, consider a system consisting of two Symphony I/Os, A and B. To 
control Symphony I/O A's Headphone 2 output from your Mac keyboard volume 
controls, set Keyboard Volume Control > Peripheral to A Symphony I/O and set 
Keyboard Volume Control > Audio Output to Headphone 2.



Using Soft Limit
Soft Limit is Apogee’s proprietary analog process for taming transients before A/D 
conversion. By gently rounding transients in a transparent manner, it’s possible to 
maximize level BEFORE the A/D conversion stage.

Soft Limit Settings
Soft Limit may be engaged on each analog input in Maestro’s Input tab window. The 
following settings are available:

-2 dBfs - Soft Limit begins to attenuate transient peaks at a level of -2 dBfs. This is 
the most transparent Soft Limit setting.
-4 dBfs - Soft Limit begins to attenuate transient peaks at a level of -4 dBfs. This is 
the threshold of previous implementations of Soft Limit.
Soft Saturate - a lower threshold, plus asymmetrical clipping in a manner similar to 
tube circuits.
Soft Crush - The most extreme setting, where audible distortion and dirty mojo are 
required. Take that, drums!

When to use Soft Limit
Soft Limit is an analog process that instantaneously rounds transient peaks; for all 
intents and purposes attack and release times may be considered instantaneous. As 
with any peak reduction device working at such fast time constants, Soft Limit is most 
effective with signals whose peak information is much greater than its average (or 
RMS) information, such as drums, percussion and plucked instruments. Soft Limit may 
not be the appropriate choice for limiting signals whose crest factor (peak to RMS ratio) 
is low, such as bass or organ.
 
The two more radical settings, Soft Saturate and Soft Crush, are intended to be used as 
creative effects rather than subtle control of digital overs. Throw caution to the wind, set 
Soft Limit to Soft Crush, Input Analog Level to Variable, and push up the slider until 
your signal is warm and crunchy!



Working with Front Panel and Maestro Level Meters

Meter Characteristics
Level meters on Symphony I/O’s front panel and throughout Maestro display audio 
levels in the range of 0 to -48 dB full scale (fs). 
An Over indicator at the top of each meter lights when three or more consecutive full 
scale samples have occurred. Though three consecutive full scale samples is most 
likely inaudible, the Over indicator serves as an “early warning” that the level should be 
reduced.
 
Peak and Over Hold
The amount of time that Peak and over indicators are held may be selected with the 
Peak Hold and Over Hold drop down menus, found in Maestro's System Setup tab 
window.
 
Both Peak and Over Hold may be set to the following times:

Off - Peaks and Overs are indicated but not held.
2 seconds - Peaks and Overs are held for 2 seconds, then cleared.
Infinite - Peaks and Overs are held infinitely (or, more accurately, a really long time) 
until cleared by the user by pressing Clear Meters in Maestro or clicking the front 
panel lefthand encoder.

Clear the Front Panel and Software Level Meters by clicking the Front Panel Left Hand 
Encoder or the Maestro Toolbar Clear Meters button. The message "Meters Cleared" 
will appear on the front panel OLED Display.
 
Front Panel Meters
Symphony I/O includes 2 banks of 8 level meters on the front panel. Select the audio 
signals to be displayed on each bank using the Meters buttons in the Device Settings 
tab window.
 



Working with VBus
Apogee's VBus is only available when Audio Interface Mode is set to Symphony. VBus 
creates virtual hardware buses to allow expanded routing of audio within one 
application or between different audio applications. For example, it’s possible in Logic 
Pro to record a submix of multiple audio tracks onto a new audio track as described 
below. It’s also possible to route between two audio applications by selecting a VBus 
output in the source application and a VBus input in the destination application. As an 
example, the output of a soft synth opened as a Standalone application may be routed 
via VBus to the inputs of your DAW application.
 
Configuring VBus
To choose the number of VBus channels, open Maestro > System Setup. In the VBUS 
drop down menu, select the number of virtual buses desired.
 
In order for VBus I/O to appear in your audio application’s I/O list as VBus In 1-2, 3-4, 
etc, it’s necessary to specify the use of the Symphony driver’s names in the 
application’s I/O list. For example in Logic Pro, open Audio>Audio 
Configuration>View>I/O Labels and option-click on all the I/O found under the Driver’s 
I/O Label column.
 
As an example of how to use VBus, let’s record a submix of drums onto a new stereo 
audio track in Logic.

1. Open Maestro and select 8 Channels under the VBus Selections menu.
2. In Logic’s Track Mixer, set the outputs of the individual drum audio tracks to 

VBout 1/2. 
3. Create two audio tracks (or one stereo track) and set their inputs to VBin 1 and 

VBin 2. 
4. Record-enable the new track and commence recording. The new track will 

record the mix of the individual drum tracks.



Working in your Digital Audio Studio
This chapter presents a variety of topics that, while not directly related to the 
Symphony I/O system, are encountered when working in the modern digital studio.

Setting Levels
Understanding Latency
Before Recording

 
Setting Levels
 
How do I set a recording level?
Once your microphone or instrument is connected, your audio software is configured 
and you’ve created a new recording track, just how do you set the input gain for a 
proper recording level in your audio software? There’s no simple answer, but with a few 
guidelines and a bit of experience, you can master setting a proper level.

Ideally, the input gain should be set so that when the input signal is at its loudest, the 
level in audio software (or in Maestro) is just below maximum without lighting the Over 
indicator. In reality, it’s unlikely that you’ll be able to guess just the right gain setting to 
accomplish this - when your gain is too low, the signal never gets close to maximum 
and when your gain is too high, a digital Over may occur.
 
Now, with a 24-bit system (such as Symphony I/O), the noise floor is so low that there’s 
no real penalty for undershooting the gain setting and recording at a lower level. There 
IS a penalty for overshooting the gain setting - a digital Over that results in significantly 
increased distortion. Thus, it’s better to work with a recording level that’s a bit too low 
than a level that’s a bit too high.
 
Just how much to undershoot the gain setting is determined by the nature of the sound 
being recorded. As a general rule, instruments such as bass and organ have a more 
consistent level than percussive instruments, such as a tambourine, and may be 
recorded at a higher level. Also, the performer’s skill and playing style can dictate 
more or less caution when setting levels. As you gain experience, you’ll be able to 
more accurately set a good recording level while avoiding digital overs.
 
How do I set the input level of my powered speakers?
Most powered speakers offer an input volume control, often labelled as input sensitivity. 
Rather than describe an overly complicated method for setting this control, the easiest 
way to determine the right setting is to note where you generally set Symphony I/O’s 
output level. If you find yourself rarely turning the output past a very low output level 
(say, -35 dB), decrease the input sensitivity on the speaker. If, on the other hand, you 
find yourself setting Symphony I/O’s level for full output and the speakers aren’t loud 
enough, increase the input sensitivity. Ideally, Symphony I/O’s Speaker output should 
be at 0 dB (i.e no attenuation) when you’re listening at your absolute maximum desired 
volume.
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Understanding Latency
 
What is latency?

When recording with most computer-based digital audio applications, a delay between 
the input and output of the recording system often disturbs the timing of the musicians 
who are performing. This delay, known at latency, means that the musician hears the 
notes he produces a few milliseconds after having produced them. As anyone who has 
spoken on a phone call with echo knows, relatively short delays can confuse the timing 
of any conversation, spoken or musical.
 
To illustrate the effect of latency, Figure A depicts the typical signal path of a vocal 
overdub session. A vocalist sings into a microphone, which is routed through a 
hardware interface to the audio software application for recording. In the software 
application, the vocalist’s live signal is mixed with the playback of previously recorded 
tracks, and routed back through the hardware interface to the vocalist’s headphones. 
Because of the audio application’s latency, the vocalist hears his performance delayed 
by several milliseconds in his headphones. 



How does Maestro resolve latency?
By routing the hardware input directly to the hardware output and mixing in playback 
as shown in Figure B, it’s possible to create a headphone listening signal with a much 
shorter delay.

First, the signal being recorded (in this case, a vocal mic) is split in the hardware 
interface and routed to both the software applicaton for recording and directly back to 
the hardware outputs without going through the latency-inducing software; this creates 
a low latency path from mic to headphones. Next, a stereo mix of playback tracks is 
routed to the low latency mixer and combined with the hardware input(s). This allows 
the performer to hear both himself without a confusing delay plus the playback needed 
for overdubbing.

Note that the software application’s mixer is used to set a stereo mix of playback tracks 
while the low latency mixer is used to set the balance between the stereo playback mix 
and the hardware inputs.

Do I need the Maestro Mixer?
The Maestro mixer serves to provide a low latency listening mix while recording. 
Therefore if you’re using Symphony I/O to listen to iTunes or audio from another 
program, there’s no need to use the mixer. 
It’s also possible that the latency of your particular recording system is low enough to 
be unnoticeable by you or other performers, especially when connecting Symphony I/
O via the Symphony 64 PCI card. If you’ve set your audio software’s input/output 
buffers according to the guidelines below and latency doesn’t bother you or other 
performers, there’s no need to use the Maestro mixer.
 
How do I set my softwareʼs I/O Buffer?



The I/O Buffer setting found in most audio software is one of the most crucial, but often 
ignored, settings in a Mac-based recording system. 
When choosing a buffer setting, a compromise between the latency through the 
application and the amount of computer processor power accessible to the application 
must be made.
 
A lower Buffer setting results in lower latency but less available processing power. If 
the application can’t access enough processor power, processor overruns may occur, 
resulting in audible clicks and pops or error messages that interrupt playback and 
recording.
 
A higher Buffer setting, on the other hand, results in greater amount of accessible 
processor power (i.e. less chance of overruns) but increases the latency. Determining 
the best setting requires some trial-and-error in order to find the best compromise.

Keep in mind that as tracks and plug-ins are added to a software session, processor 
requirements increase. Thus, the buffer setting that works during the early stages of a 
session might result in processor overruns during later stages. 
The best strategy is to set the buffer to a lower setting during recording and accept 
certain limitations on plug-in usage, and then raise the buffer during mixing to utilize 
the computer’s full processor power when latency isn’t an issue.
With the processing power of today’s Macs, you may find that adjustment of the Buffer 
isn’t necessary, and you can leave it at a setting for low latency and still access a 
sufficient amount of processing power when adding tracks and plug-ins. If you do 
encounter clicks, pops or software errors, don’t hesitate to experiment with the Buffer 
setting.



FAQs
 
Q: What is the Audio Interface Mode?
A: The Audio Interface Mode (AIM) setting transforms the most fundamental 
characteristics of the Symphony I/O system to best match the host device to which 
Symphony I/O is connected. Rather than create a single hardware and software user 
interface that must adapt to all connection scenarios, the Audio Interface Mode 
customizes the user interface to your specific scenario, thus simplifying operation.
 
The Audio Interface Mode is set by pressing and holding the front panel right hand 
encoder, selecting the desired Audio Interface Mode by turning the encoder, then 
pressing the encoder to re-boot Symphony I/O in the new Audio Interface Mode
 
Q: What I/O Modules are available?
A: For Symphony I/O Release 4, the following I/O Modules are available:

• 8 Analog I/O + 8 Optical I/O
• 8 Analog I/O + 8 AES I/O
• 16 Analog In + 16 Optical Out
• 16 Analog Out + 16 Optical In
• Mic Pre Module

Q: Why do I see overs on Symphony I/Oʼs meters but not in my DAWʼs meters?
A: Symphony I/O and Maestro’s over indicators are set to light when 3 or more 
consecutive full scale samples occur. This threshold may be lower than other hardware 
or software over indicators, but you probably want to know when overs occur, no?
 
Q: What type of screw is needed to secure DB-25 terminated cables to Symphony 
I/Oʼs rear panel Analog In, Analog Out and AES In/Out connectors?
A: Use DB-25 connectors equipped with 4-40 thread screws.
 
Q: What is the difference between configuring my Symphony I/O with 2 8x8 I/O 
Modules or a 16 IN Module and 16 OUT Module?
A: Installing a 16 IN and a 16 OUT I/O Module gives exactly the same number of 
analog and digital I/O as two 8x8 I/O Modules, but the 2 8x8 I/O Modules more closely 
mirror the operation of 2 Avid 192s, and also offers the AES option. Thus, it's the 
preferred combination for someone looking for 16 analog/16 digital I/O. The 16 IN/OUT 
I/O Modules make most sense when a customer wants a large number of analog inputs 
or outputs, such as 24x8, 32x0, 0x16, etc.
 
Q: Does Symphony I/O work with Symphony 32 PCIe and PCIx cards?
A: Symphony I/O is not compatible with any Symphony 32 PCI card. When in the 
“Symphony” Audio Interface Mode, Symphony I/O is only compatible with the 
Symphony 64 PCIe card. For a limited time, all Symphony 32 users who provide a sales 
receipt for Symphony I/O are eligible to purchase a Symphony 64 PCI card direct from 
Apogee at 50% off list (Symphony 64 PCI list price - $995 USD). This program is 



offered worldwide, each Symphony 32 card must be registered and a photo of the 
Symphony 32 card is required. Trade-in of the Symphony 32 card is not required. 
Please email us via the ASK APOGEE submission form.
 
Q: Is it possible to run other Apogee interfaces (such as Duet, ONE and GiO) and 
Symphony I/O on the same Mac.
A: Yes it is. Use Maestro 1 with Ensemble, Duet and ONE, use Maestro 2 with 
Symphony I/O.
 
Q: Why does Symphony I/O have USB 2.0 and not FireWire?
A: USB 2.0 offers the same great performance as FireWire with up to 16 channels at 
96kHz. Also, with Symphony I/O connected to the USB bus, this allows for FireWire 
external hard drives to be connected to the FireWire bus eliminating any conflict 
between the two.
 
Q: Does Symphony I/O have better conversion quality than Rosetta Series and X-
Series converters?
A: Yes. Symphony I/O features upgraded components with a shorter conversion path 
resulting in lower converter latency, more accurate clocking and even more 
transparency and clarity in recordings.
 
Q: Is it possible to run a legacy Symphony system and a Symphony I/O on the 
same Mac?
A: Each system may be run on the same Mac, but not simultaneously. When using an 
X-Symphony equipped Rosetta Series or X-Series converters, open Maestro 1; when 
using Symphony I/O, open Maestro 2.
 
Q: Can Rosetta Series and X-Series converters be connected to Symphony I/O?
A: In the future, Apogee will release a firmware update for connecting Rosetta Series 
and X-Series converters on the same Symphony System as Symphony I/O. Currently 
these converters can be connected via digital I/O such as Optical, AES, and S/PDIF.
 
Q: Does Symphony I/O support analog and digital I/O simultaneously?
A: Yes, with all I/O Modules both analog and digital I/O can be used simultaneously.
 
Q: Which I/O Modules may be installed in Slot 1, the lower slot?
A: Any I/O Module except the Mic Preamp Module may be installed in the lower slot.
 
Q: Which I/O Modules may be installed in Slot 2, the upper slot?
A: Once an I/O Module is installed in the lower slot (Slot 1), any second I/O Module 
may be installed in the upper slot (Slot 2).
 
Q: Where do I connect a microphone to the Mic Preamp Module?
A: Microphone’s do not connect directly into the Mic Preamp Module. You must 
connect microphone’s to the analog inputs of the I/O Module installed in slot 1 and then 
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enable the Mic Preamp for that input in Maestro. However, up to 4 instrument inputs 
can be connected directly into the Mic Preamp Module’s instrument inputs.
 
Q: What is Soft Limit™?
A: Soft Limit™ is a superior analog design preventing the digital clipping that causes 
distortion by instantaneously rounding off transient peaks before they hit the analog-to-
digital converter. This technology allows several more decibels of apparent level to be 
recorded while subtly providing an analog-like warmth to the sound. With Symphony I/
O and Maestro 2, there are 4 available settings: -2 dB. -4 dBfs, Soft Saturate and Soft 
Crush. Each setting possesses its own characteristics for a wide range of versatility in 
the analog-to-digital conversion process.
 
Q: Can the headphone outputs on Symphony I/O be used when I/O Modules are 
not installed?
A: I/O Modules must be installed in order for Symphony I/O to pass audio.
 
Q: Will Symphony I/O work without a Symphony 64 PCI-e card?
A: Yes, Symphony I/O is compatible with a Pro Tools HD Core card for connecting to 
Pro Tools, USB 2.0 for connecting to any Core Audio application or connect to any 
analog or digital I/O equipped interface via Symphony I/O’s analog or digital I/O.

Q: How loud is Symphony I/Oʼs fan?
A: Symphony I/O’s fan operates at a quiet whisper and is software controlled with 
multiple settings depending on the units internal temperature.
 
Q: What length USB cable may be used?
A: USB cables up to 15 feet are supported. Be sure to use a cable that is certified for 
USB 2.0 operation.
 
Q: How do I switch between Pro Tools and Logic?
A: To switch between Pro Tools and Logic you will use the same Symphony Cable 
connected to the Symphony port on Symphony I/O and move the opposite end from 
the Pro Tools Core card and connect to the Symphony 64 card. Then on Symphony I/
O’s front panel press and hold the right-hand encoder to display the currently selected 
Audio Interface Mode, press the right-hand encoder again and turn to select 
“Symphony” as the mode.
 
Q: How do I connect Symphony I/O to my Pro Tools LE or M-Powered system?
A: Using Standalone Audio Interface Mode, Symphony I/O can be connected to any 
Avid/Digidesign/M-Audio Pro Tools LE or Pro Tools M-Powered interface via optical or 
S/PDIF.
 
Q: Do I use the same PC-32 cable for both Symphony and Pro Tools HD?
A: Yes, the Apogee PC-32 cable will connect Symphony I/O to both Symphony and Pro 
Tools HD.
 



Q: Can Symphony I/O be connected to two Mac Proʼs at the same time, one for 
Symphony and the other for Pro Tools HD?
A: Even though there are two Symphony ports on the rear panel of Symphony I/O, only 
the ‘MAIN’ port can be connected to Symphony 64 or the Pro Tools HD Core card. 
Therefore Symphony I/O cannot be connected to Symphony and Pro Tools HD at the 
same time, whether it be one Mac Pro or two. Symphony I/O’s ‘THRU’ port is for 
connecting multiple Symphony I/O’s on one system only.
 
 
Maestro FAQs
 
Q: Is Maestro 2 compatible with all Apogee products?
A: Currently Maestro 2 is compatible with Ensemble, Duet FW, One, Duet USB and 
Symphony I/O. Maestro 1 should be used with all other products.
 
Q: Is it possible to run Symphony I/O along with other Apogee interfaces on the 
same Mac.
A: Yes it is. Use Maestro 2 with Ensemble, Duet FW, One, Duet USB and Symphony I/O. 
Use Maestro 1 with all other Apogee interfaces.
 
Q: Where is the Maestro 2 download located?
A: Maestro 2 is included in the Symphony I/O installer package.



Troubleshooting
 
 Symphony Audio Interface Mode

 
When troubleshooting the Symphony I/O - Symphony PCI card system, first verify these 
three items. If one or more of the items is found to be operating incorrectly, see the 
Symptoms and Solutions lower in this section.

1. Verify system status
2. Verify Audio streaming
3. Verify Hardware-Software Control Link

Verify system status
When using Symphony I/O with the Symphony 64 PCI card, first check the 64 card's 
Status LEDs, found on the card's rear panel.

1. If only one card is installed, a blue and white LED should be solidly lit.
2. If multiple cards are installed, white LEDs should be solidly lit on all cards while a 
blue LED should be lit on one card.
3. If any LEDs are flashing, consult the chart below for detailed troubleshooting 
information.



If Symphony I/O hardware is successfully detected in Maestro, the system status may 
also be determined in the System Status window, found in Maestro's Toolbar. When 
System Status is displayed as "Ready", all detected hardware interfaces are properly 
connected and clocked.
 
Verify Audio Streaming
1. Open Audio MIDI Setup by choosing Applications > Utilities > Audio MIDI Setup.
2. In AMS, choose Window > Show Audio Window.
3. In the left hand Devices column, select Symphony 64.
4. Play a selection from iTunes.

Verify Hardware-Software Control Link
1. Open Apogee Maestro software.
2. In the Devices sidebar, verify that the heading Symphony 64 (or Mobile) PCI 
appears, and that Symphony I/O appears underneath this heading.
3. Click the ID button and verify that the front panel meters light.

Symptoms and Solutions
 



Symptom: The Symphony 64 card's white status LED is blinking, but the front panel 
sample rate is solidly lit.
Solution: Check the PC-32 connection between the Symphony I/O(s) and the 
Symphony 64 card.
 
Symptom - The front panel sample rate display is blinking and indicates a different 
rate than my DAW session; Maestro System Status is "Clock Mismatched"; the 
Symphony 64 card's white status LED is blinking.
Solution - This behavior indicates that Symphony I/O is locked to an external clock at 
the indicated rate, but that this rate is mismatched to the session sample rate. Match 
the rate of the external clock to the rate of the DAW session.
 
Symptom - The front panel sample rate display indicates 00.00 and is blinking. The 
Symphony 64 card's white status LED is blinking.
Solution - This behavior indicates that Symphony I/O has been set to lock to an 
external clock source, but no valid clock is detected at the selected clock input (WC, 
SPDIF Coax, etc.). Connect a valid clock signal to the selected clock input or set 
Symphony I/O’s clock source to Internal.
 
Symptom - Symphony 64 doesn't appear as an audio selection in Audio MIDI Setup, 
System Audio Preferences or DAW hardware selection dialogs; the Symphony 64 
card's blue status LED is flashing.
Solution - Re-install the Symphony 64 driver. Reboot OS X Snow Leopard into 32-bit 
mode.
 
Symptom - Symphony I/O isn’t detected in Maestro's Devices Sidebar.
Solution - Check that Symphony I/O is powered on.
Check the PC-32 connection between the Symphony I/O(s) and the Symphony 64 
card.
Ensure that the Symphony Source drop down (In the Maestro System Setup tab) is set 
correctly. For example, when 1 Symphony I/O is connected, set Symphony Source to 
PCI Card 1, Port 1 (CHANNELS 1-32).
 
Symptom - Audio input (or output) has clicks and pops.
Solution - Set the I/O Buffer in your DAW software to a higher setting.
 
Symptom - There's no audio output from Symphony I/O, though all other indicators are 
correct.
Solution - Verify that the Audio MIDI Setup Mute box is NOT checked. Verify that NO 
exclamation point appears on the OLED (see below if an exclamation point is shown).
 
Symptom - There's an exclamation point displayed in the front panel OLED. Did I win 
something?
Solution - The exclamation point indicates that 1) Symphony drivers aren't installed or 
that the connection between Symphony I/O and the Symphony 64 card isn't 
communicating correctly. Check this connection; 2) a mismatch exists between 



Symphony I/O's external clock source and the rate of the DAW session. Conform the 
rate of the source to that of the session.
 

Pro Tools HD Audio Interface Mode

When troubleshooting the Symphony I/O - Pro Tools HD PCI card system, first verify 
these two items. If one or more of the items is found to be operating incorrectly, see the 
Symptoms and Solutions lower in this section.

1. Launch Pro Tools, choose Hardware > Setup, and verify that Symphony I/Os with 
one I/O Module are detected as one 192 I/O and Symphony I/Ow with two I/O Modules 
are detected as two 192 I/Os.
2. Open Apogee Maestro software and verify that the heading USB appears, and that 

Symphony I/O appears underneath this heading.

Symptom - Upon launching Pro Tools, the message "Unable to find an audio interface 
attached to the first HD card".
Solution - Verify that Symphony I/O's audio interface mode is set to Pro Tools HD. See 
Setting the Audio Interface Mode.
Verify that the cable connecting Symphony I/O's Main port to the Pro Tools HD Core 
PCI card is firmly connected on both ends.
 
Symptom - Some interfaces are not detected in Pro Tools' Hardware Setup
Solution - Check that one hardware interface is set to Internal and all others are set to 
Loop clock source.
Verify that the PCI card's channel limitation has not been exceeded - a Symphony I/O 
with two I/O Modules occupies all 32 channels of I/O provided by the Pro Tools HD PCI 
card; units connected to Symphony I/O's Thru port won't be recognized.
 
Symptom - Symphony I/O isn't recognized in Apogee Maestro software.
Solution - Verify that Symphony I/O's audio interface mode is set to Pro Tools HD. See 
Setting the Audio Interface Mode.
Connect directly to the Mac's USB port, bypassing any USB hubs.
Verify that the USB connection is seen in the OS X utility System Profiler. Launch 
System Profiler, open the Hardware disclosure triangle, click USB, and verify that 
Symphony I/O appears in the USB Device Tree. If if doesn’t appear, power-cycle the 
unit, hot-plug the unit or power-cycle the Mac, until Symphony I/O is detected. After 
each attempt, choose View > Refresh to rescan the USB bus(es).
 



Symptom - There's an exclamation point displayed in the front panel OLED. Why so 
excited?
Solution - The exclamation point indicates that 1) Symphony I/O isn't communicating 
with software, either through Pro Tools or through the Digi Core Audio driver. Launching 
Pro Tools should cause the exclamation point to disappear 2) Symphony I/O is clocked 
to an external source, and the rate of the source doesn't match the rate of the Pro Tools 
session. Conform the rate of the source to that of the session.

General Troubleshooting - All Audio Interface Modes
 
Resetting Symphony I/O
To reset Symphony I/O to its default settings
1. Power off the unit.
2. Press the left hand encoder, and while holding down the left hand encoder, power 
up the unit.
3. Turn the left hand encoder to select either Reset All or Reset All but Cal.
Choose Reset All to reset all settings including level calibration settings.
Choose Reset All but Cal to reset all settings but the level calibration settings - Analog 
reference, digital reference and Trim.
4. Turn the right hand encoder to Yes.
5. Press either encoder.
6. To proceed without resetting, turn the right hand encoder to No and press either 

encoder.

Troubleshooting Signal Flow
To best troubleshoot signal flow through from Symphony I/O's hardware inputs through 
to audio software and back to Symphony I/O's hardware outputs, follow these steps:
 
Open Apogee Maestro and click the Input tab.
In the Input tab window, is the signal present on the Input meter corresponding to the 
physical hardware input? If not, check the input hardware connection. If so, continue 
with the next step.
In the audio software, record enable a track. Is the signal present on the track's input 
meter. If not, check the connection between Symphony I/O and the computer. Check 
that the audio software is configured for use with Symphony I/O (via the Symphony PCI 
card, the Pro Tools HD card or the OSX USB Audio driver). If so, continue with the next 
step.
In the software, route the audio input to an audio output. In Maestro, click the Output 
tab. Is the signal present on the Output meter corresponding to the software output? If 
not, check routing in the audio software.
If signal is present in Maestro's Output tab but there's still no output on the hardware 
output, check that outputs aren't muted (an "M" or excalmation point appears on the 
front panel OLED display). Check that the Output level isn't set to a very low setting.
 



 
Further Troubleshooting Resources
 
If, after perusing the FAQ and Troubleshooting sections, you still haven't found a 
resolution to your issue, Apogee provides a wide range of resources to help you.
 
Apogee Website
For any questions concerning product information, please visit our website: 
www.apogeedigital.com
To peruse Apogee videos, including Symphony I/O Module Installation tutorials, please 
visit our video section: video.apogeedigital.com
For more technical information, including FAQs, User Guides and downloads, please 
visit the support section:support.apogeedigital.com
 
Apogee Support
Apogee's Support department may be contacted via email, telephone or Live chat. In 
order to provide you with the most efficient technical support, we ask you to register 
your Apogee product before contacting us, at:apogeedigital.com/account.php. Also, 
it's best to have the Apogee product on-hand and operational when calling Support.
 
Email: support@apogeedigital.com
Phone support is available from 7am to 7pm (19h00) Pacific Standard Time at: +1 
(310) 584-9394
Live chat is availabe from 10am to 4pm (16h00) Pacific Standard Time - please go to 
support.apogeedigital.com
Fax Apogee Support at: +1 310 584-9385

Apogee Product Repair
If, for some reason, your Apogee product requires repair, please contact Apogee 
Support to obtain a Return Materials Authorization (RMA).
 
Any Apogee product shipped to us without a clearly indicated RMA number must be 
refused delivery.
 
Please consult the Warranty information for more details.
 
Symphony I/O Hardware
This chapter provides information about internal settings, IO Module installation, 
connectors pinouts, hardware characteristics and performance specifications.

Racking mounting Symphony I/O
Installing I/O Modules
Auto Power
Updating Symphony I/O
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Specifications
Connector Pinouts
 

Rack mounting Symphony I/O
Rack ears are included in the Accessories box for mounting Symphony I/O in a 
standard 19” equipment rack.
1. Orient one rack ear to line up the ear's three holes with three holes found on the 

side of the chassis immediately behind the front panel extrusion.
2. Insert 3 screws (included) and finger tighten.
3. Connect the second rack ear to the other side of the chassis.
4. On each side, line up the top and bottom of the rack ear with the top and bottom of 

the front panel extrusion and tighten the screws with a Phillips screwdriver. Don't 
overtighten the screws.

5. Remove the screw-on feet by turning them counter-clockwise by hand or with a 
Philips screwdriver.

 
Authorized Symphony I/O Module Install Technicians
 
If you would like to have an authorized technician install your modules for you, please 
consult this list:

Alto
AudioMidi
Calistro Music
Dale Pro Audio
Doug Roberts Systems
EAR
Full Compass
GC Pro
Long & McQuade
Marshall Graphics
Mercenary
Sonic Circus
Sonotechnique
Studio Economik
Sweetwater
Tekserve
Tidepool Audio
Vintage King
Westlake Pro
West LA Music
 
Installing I/O Modules
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In most cases, Symphony I/O ships with the first I/O Module installed. For the 
infrequent case where no I/O Modules are installed, we recommend having them 
installed by Authorized Symphony I/O Technicians.

If you are brave enough to install them on your own, this section describes both how to 
install the first I/O Module as well as a second I/O Module.
 
Symphony I/O Screws
Be careful to keep track of these screws and use them only for their intended purposes



Directions
 
1. Discharge Residual Electricity- IMPORTANT! Even when Symphony I/O is powered 

off but connected to the AC wall socket, voltages remain active throughout the 
system. Manipulating circuit boards under these conditions may result in permanent 
damage.

 a. Turn Symphony I/O off, but leave the AC cable connected
 b. Ground yourself by touching the front panel of Symphony I/O to discharge 
static  electricity
 c. Unplug the AC cable from Symphony I/O
 d. Wait for at least 2 minutes to let the power discharge from the circuitry
 
2. Use a Phillips screwdriver to remove the 11 screws holding the cover on.



3. To remove the cover, slide it straight back until the underside clips prevent further 
movement. Then grasp the cover's side panels and gently bow the cover until the 
bottom lip is free.

 
4. Remove the 2 screws holding the center support in place, and lift out the support.
 

 
5. Remove both I/O Module blanking panels and set the screws aside for later use.



 

 
6. Remove the 9 screws indicated below, and set them aside for later use.

 



7. Place the first I/O Module into the chassis by inserting the I/O Module rear panel into 
the Symphony I/O Card 1 opening, then gently dropping the front of the I/O Module into 
place. Line up the I/O Module's mounting holes with the 9 nuts on the bottom of the 
chassis.

 
8. Secure the I/O Module by installing the 9 screws removed in Step 6. If you're 
installing a second I/O Module, install 9 stand-offs in the place of the 9 screws.

 

 



9. Secure the I/O Module rear panel to the chassis rear panel using the two screws 
from Step 4.
 
10. If you are only installing a single Module, replace the second slot's blanking panel.
 
11. Connect the provided ribbon cable between J1 on the Main board and J1 on the I/
O Module. Be sure to align the key on each ribbon cable connector to the key slot on 
each receptacle.

 

 
 

 
 
12. To install a second Module, insert the I/O Module rear panel into the Symphony I/O 
Card 2 opening, then gently dropping the front of the I/O Module into place. Line up 
the second I/O Module's mounting holes with the tops of the 9 stand-offs.
 



13. Connect the provided ribbon cable between J2 on the Main board and J1 on the 
second I/O Module. Make sure that the lower Module ribbon cable is nested into the 
upper Module ribbon cable as shown below.

 

Do not tuck the Primary I/O ribbon cable underneath the second Module or it could 
become frayed.
 
14. Reconnect the center support bar.
 
15. Reserving the steps to remove the cover, slide it back into place and secure with 
the 11 screws removed in Step 2. Use 6 undercut screws to secure the cover bottom 
and 5 round head screws to secure the cover's rear tab.



Auto Power
To configure Symphony I/O to power on as soon as AC power is present on the rear 
panel AC input, follow these steps. Auto Power is useful in circumstances where an 
external power switch is used to power on multiple devices, such as a rack of 
Symphony I/Os with a master power switch.
1. Disconnect Symphony I/O’s AC input.
2. Remove the top cover as described in Installing I/O modules.
3. Place a jumper across pins J18 (whose location is indicated below).
4. Replace the top cover before applying AC power.
5. The front panel power switch remains operational.



Updating Symphony I/O
Maestro includes an update notification feature that is enabled simply by connecting 
your Mac to the Internet. Maestro will ping Apogee servers to determine the latest 
versions of Symphony I/O firmware and software, and notify you if updates are 
available. If updates are available, the dialog shown below appears.
 

 
Click on the link provided in the dialog and download the Symphony I/O firmware and/
or software updates.
 
To update firmware:
1. Connect the Symphony I/O USB port to your Mac using a standard USB 2.0 cable
2. Unzip the Firmware Updater package
3. Launch the Firmware Updater application by double-clicking on the Firmware 

Updater icon
4. Click “OK” to update firmware

To update software:
1. Unzip the Software Installer
2. Launch the Software Installer by double-clicking on the icon
3. Follow on-screen directions
4. Re-start after the installation is complete



Specifications
 
Highlights:
A/D THD+N: -113dB @ +20dBu (0.00024%)
D/A THD+N: -117dB @ +20dBu (0.00014%)
D/A Dynamic Range: 129dB A weighted
Apogee’s proprietary Perfect Symmetry Circuitry (PSC)
Software controlled AD/DA reference setting
Variable gain input for keyboards
Ultra low latency AD/DA conversion
 
Analog to Digital:
THD+N: -113dB @ 20dBu (0.00024%)
Dynamic range: 120dB A weighted
Maximum input levels:
+4dB setting - 24dBu
-10dB setting - +6dBV
Variable gain setting - 25dB of gain
Frequency response at 44.1kHz 1-20,000 Hz (+/- 0.05dB)
Input impedance: 10K

Digital to Analog:
THD+N: -117dB @ 20dBu (0.00014%)
Dynamic Range: 129dB A weighted
Max output levels - ∞ to +24dBu
Frequency response at 44.1 kHz: dc to 20kHz (+/- 0.05dB)
Output impedance: 25 Ohm
Outputs are balanced through Apogee's proprietary Perfect Symmetry Circuitry (PSC)

Headphones:
THD+N: -105dB @19dBu
Dynamic Range: 119db A weighted
Output impedance: 30 Ohm

Power:
90-240VAC, 50-60Hz, 150W

Operating System:
Mac OS 10.5.8 or greater
 
Package Contents:
Symphony I/O Interface
USB Cable
Power Cable
Rack Ears and Screws
Quick Start Guide



 
Packaging Sizes:

Symphony I/O Chassis Box
Inches: 22.875 L x 17.75 W x 9.25 D
Centimeters: 58.1 L x 45.1 W x 23.5 D
 
I/O Module Box
Inches: 13.75 L x 12.25 W x 3.25 D
Centimeters: 34.9 L x 31.1 W x 8.3 D
 
 
 



Connector Pinouts
 
Analog IN Pinout

Analog OUT Pinout

AES IN/OUT Pinout

http://support.apogeedigital.com/help/symphony-io/pgs/hardware_connector_pinouts.html#analogin
http://support.apogeedigital.com/help/symphony-io/pgs/hardware_connector_pinouts.html#analogin
http://support.apogeedigital.com/help/symphony-io/pgs/hardware_connector_pinouts.html#analogout
http://support.apogeedigital.com/help/symphony-io/pgs/hardware_connector_pinouts.html#analogout
http://support.apogeedigital.com/help/symphony-io/pgs/hardware_connector_pinouts.html#aesinout
http://support.apogeedigital.com/help/symphony-io/pgs/hardware_connector_pinouts.html#aesinout








Symphony I/O Warranty Information and Legal Notices
 
Registration and Warranty Information
Be sure to register your Symphony I/O, either by filling in the enclosed Registration 
Card or by completing the on-line registration form at our Web site: apogeedigital.com/
account.php
If you do so, Apogee can contact you with any update information. As enhancements 
and upgrades are developed, you will be contacted at the registration address. 
Firmware updates are free for the first year of ownership unless otherwise stated.
 
Please address any inquiries to your dealer or directly to Apogee at:
APOGEE ELECTRONICS CORPORATION
1715 Berkeley St Santa Monica,CA 90404, USA
TEL: (310) 584-9394, FAX: (310) 584-9385
email: support@apogeedigital.com
web: Ask Apogee
 
APOGEE ELECTRONICS CORPORATION warrants this product to be free of defects in 
material and manufacture under normal use for a period of 12 months. The term of this 
warranty begins on the date of sale to the purchaser. Units returned for warranty repair 
to Apogee or an authorized Apogee warranty repair facility will be repaired or replaced 
at the manufacturer’s option, free of charge.
 
ALL UNITS RETURNED TO APOGEE OR AN AUTHORIZED APOGEE REPAIR FACILITY 
MUST BE PREPAID, INSURED AND PROPERLY PACKAGED, PREFERABLY IN THEIR 
ORIGINAL BOX.
 
Apogee reserves the right to change or improve design at any time without prior 
notification. Design changes are not implemented retroactively, and the incorporation 
of design changes into future units does not imply the availability of an upgrade to 
existing units. This warranty is void if Apogee determines, in its sole business 
judgment, the defect to be the result of abuse, neglect, alteration or attempted repair 
by unauthorized personnel. The warranties set forth above are in lieu of all other 
warranties, expressed or implied, and Apogee specifically disclaims any and all 
implied warranty of merchantability or of fitness for a particular purpose. The buyer 
acknowledges and agrees that in no event shall the company be held liable for any 
special, indirect, incidental or consequential damages, or for injury, loss or damage 
sustained by any person or property, that may result from this product failing to operate 
correctly at any time.
 
USA: Some states do not allow for the exclusion or limitation of implied warranties or 
liability for incidental or consequential damage, so the above exclusion may not apply 
to you. This warranty gives you specific legal rights, and you may have other rights 
which vary from state to state. 
 
Service Information

http://www.apogeedigital.com/account.php
http://www.apogeedigital.com/account.php
http://www.apogeedigital.com/account.php
http://www.apogeedigital.com/account.php
mailto:support@apogeedigital.com
mailto:support@apogeedigital.com
http://www.apogeedigital.com/products/ask-apogee-main.php
http://www.apogeedigital.com/products/ask-apogee-main.php


The Symphony I/O contains no user-serviceable components; refer to qualified service 
personnel for repair or upgrade. Your warranty will be voided if you tamper with the 
internal components. If you have any questions with regard to the above, please 
contact Apogee. 
In the event your Symphony I/O needs to be upgraded or repaired, it is necessary to 
contact Apogee prior to shipping, and a Return Materials Authorization (RMA) number 
will be assigned. This number will serve as a reference for you and helps facilitate and 
expedite the return process. Apogee requires that shipments be pre-paid and insured 
— unless otherwise authorized in advance.
IMPORTANT: ANY SHIPMENT THAT IS NOT PRE-PAID OR IS SENT WITHOUT AN RMA 
NUMBER WILL NOT BE ACCEPTED.

Warnings

FCC warning
This equipment has been tested and found to comply with the limits for a Class A 
digital device, pursuant to Part 15 of the FCC rules. These limits are designed to 
provide reasonable protection against harmful interference when operated in a 
commercial environment. This equipment generates, uses, and can radiate radio 
frequency energy and, if not installed and used in accordance with the instruction 
manual, may cause harmful interference to radio communications. Operation of this 
equipment in a residential area is likely to cause harmful interference, in which case the 
user will be required to take whatever measures necessary to correct the interference 
at his own expense.
 
Copyright Notice
Symphony I/O is a computer-based device, and as such contains and uses software in 
ROMs. This software, and all related documentation, including this User’s Guide 
contain proprietary information which is protected by copyright laws. All rights are 
reserved. No part of the software and its related documentation may be copied, 
transferred, or modified. You may not modify, adapt, translate, lease, distribute, resell 
for profit or create derivative works based on the software and its related 
documentation or any part thereof without prior written consent from Apogee 
Electronics Corporation, U.S.A.
 
Software Notice
Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met:
1. Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution.
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND 
CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 



MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. 
IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR 
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE 
GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE 
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, 
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Declarations of Conformity
This device complies with Part 15 of the FCC Rules. Operation is subject to the 
following two conditions: 
1. This device may not cause harmful interference
2. This device must accept any interference received, including interference that may 
cause undesired operation.
This equipment has been tested and found to comply with the limits of a Class B digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful inteference in a residential installation. This 
equipment generates, uses and can radiate radio frequency energy and, if not installed 
and used in accordance with the instructions, may cause harmful interference to radio 
communications. If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the equipment off and on, the 
user is encouraged to try to correct the interference by one or more of the following 
measures:
1. Re-orient or relocate the receiving antenna.
2. Increase the separation between the equipment and receiver.
3. Connect the equipment into an outlet on a different circuit from that to which the 
receiver is connected.
4. Consult the dealer or an experienced radio/TV technician for help.
NOTE: The use of non-shielded cable with this equipment is prohibited.
 
CAUTION: Changes or modifications not expressly approved by the manufacturer 
responsible for compliance could void the userʼs authority to operate the 
equipment.

Apogee Electronics Corp.
1715 Berkeley Street
Santa Monica,CA 90404, USA
 
Betty Bennett, CEO.

Industry Canada Notice



This Class B digital apparatus meets all requirements of the Canadian Interference-
Causing Equipment Regulations. Cet appareil numérique de la classe B respecte 
toutes les exigences du Règlement sur le matérial brouilleur du Canada.
Declaration of Conformity – CE

Apogee Electronics Corporation hereby declares that the product, the Symphony I/O, 
to which this declaration relates, is in material conformity with the following standards 
or other normative documents:
• EN50081-1/EN55022; 1995
• EN50082-1/IEC 801-2, 3, 4; 1992
following the provisions of:
• 73/23/EEC – Low Voltage Directive
89/336/EEC – EMC Directive
Declaration of Conformity – Japan
Apogee Electronics Corporation hereby declares that Symphony I/O, to which this 
declaration relates, is in material conformity with the VCCI Class A standard.
 
Declaration of Conformity – Australia
Apogee Electronics Corporation hereby declares that the Symphony I/O is in material 
conformity with AN/NZS standard requirements.


